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1 • Introduction

1.1 Introduction to Ion Chromatography (IC)

NOTE Appendix E contains a glossary of chromatography
terms. 

The Dionex ICS-90 Ion Chromatography System (ICS-90) performs isocratic ion 
analyses using suppressed conductivity detection. An ion chromatography system 
typically consists of a liquid eluent, a high-pressure pump, a sample injector, a 
separator column, a chemical suppressor, and a conductivity cell. Before running 
a sample, the ICS-90 is calibrated using a standard solution. By comparing the 
data obtained from a sample to that obtained from the standard, sample ions can 
be identified and quantitated. A computer running chromatography software 
automatically converts each peak in a chromatogram to a sample concentration 
and produces a tabulated printout of the results. 

The IC analysis consists of four stages (see Figure 1-1):

1. Eluent Delivery 

• Eluent, a liquid that helps to separate the sample ions, carries the 
sample through the ion chromatography system. The ICS-90 is an 
isocratic delivery system. This means that the eluent composition and 
concentration remain constant throughout the run. 

• Liquid sample is injected into the eluent stream either manually or 
automatically (if an automated sampler is installed).

• The pump forces the eluent and sample through a separator column (a 
chemically-inert tube packed with a polymeric resin). 

2. Separation

• As the eluent and sample are pumped through the separator column, 
the sample ions are separated. In the ICS-90, the mode of separation 
is called ion exchange and it is based on the premise that different 
sample ions migrate through the IC column at different rates, 
depending upon their interactions with the ion exchange sites.
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3. Detection

• After the eluent and sample ions leave the column, they flow through 
a suppressor that selectively enhances detection of the sample ions 
while suppressing the conductivity of the eluent.

• A conductivity cell monitors and measures the electrical conductance 
of the sample ions as they emerge from the suppressor and produces a 
signal based on a chemical or physical property of the analyte.

4. Data Analysis

• The conductivity cell transmits the signal to a computer running 
chromatography software.

• The chromatography software analyzes the data by comparing the 
sample peaks in a chromatogram to those produced from a standard 
solution. The software identifies the ions based on retention time, and 
quantifies each analyte by integrating the peak area or peak height. 
The results are displayed as a chromatogram, with the concentrations 
of ionic analytes automatically determined and tabulated.

Figure 1-1.  Ion Analysis Process
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1.2 Overview of the ICS-90

In all major respects, the ICS-90 operating process is similar to the overview of 
ion analysis described in Section 1.1. 

The ICS-90 is an integrated ion chromatography system containing a pump, an 
injection valve, and a conductivity cell. Other system components, including a 
guard column, separator column, and suppressor, must be ordered separately. 
These components vary, depending on the analyses to be performed. System 
components are described and illustrated in Section 2.1.3. 

ICS-90 operation is controlled remotely by a PC (personal computer) running 
Microsoft® Windows® XP or Windows® 2000 operating system and either the 
Chromeleon® Chromatography Management System or Chromeleon Xpress 
chromatography software. Chromeleon provides all of the system control features 
found in Chromeleon Xpress, plus complete data acquisition and data processing 
functions.

For communication between the ICS-90 and the PC on which Chromeleon or 
Chromeleon Xpress is installed, the ICS-90 must be connected to a USB 
(Universal Serial Bus) port on the PC or a USB hub. For installation instructions, 
see Appendix B of this manual.

Product Versions
A newer version of the ICS-90, called the ICS-90A, has a feature that allows the 
approximate flow rate to be displayed in Chromeleon or Chromeleon Xpress (see 
Section B.15). Unless otherwise specified, all of the information in this manual 
applies to both the ICS-90 and the ICS-90A. If you are unsure which system you 
have, check the model data label on the rear panel.
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1.3 About This Manual

Chapter 1
Introduction

An introduction to ion analysis and the ICS-90. Explanations 
of the conventions used in this manual, including safety-
related information.

Chapter 2
Description

Descriptions of ICS-90 operating features and the 
chromatographic flow path. An introduction to the software 
required for ICS-90 control.

Chapter 3
Operation and

Maintenance

Instructions for routine operation with Chromeleon or 
Chromeleon Xpress. Routine preventive maintenance 
procedures for the ICS-90.

Chapter 4
Troubleshooting

Minor problems that may occur during operation, with step-
by-step procedures for how to isolate and eliminate the cause 
of each problem. A list of Chromeleon and Chromeleon 
Xpress Audit Trail error messages, with an explanation of the 
possible cause of each message and the corrective action to 
take.

Chapter 5
Service

Step-by-step instructions for routine service and parts 
replacement procedures for the ICS-90.

Appendix A
Specifications

Specifications and installation site requirements for the 
ICS-90.

Appendix B
Installation

Installation instructions for the ICS-90.

Appendix C
Reordering

Information

Spare parts for the ICS-90.

Appendix D
FAQ

Answers to frequently asked questions about ICS-90 
operation.

Appendix E
Glossary

Definitions of terms commonly used in ion analysis.
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1.3.1 Safety Messages and Notes
The ICS-90 is designed for ion analysis applications and should not be 
used for any other purpose. If there is a question regarding appropriate 
usage, contact Dionex at 1-800-346-6390 before proceeding. Outside the 
United States, call the nearest Dionex office.

This manual contains warnings and precautionary statements that, when 
properly followed, can prevent personal injury and/or damage to the 
instrument. Safety messages appear in bold type and are accompanied by 
icons, as shown below.

Messages d’avertissement en français

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures mineures à modérées. Également
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entraînera pas de
blessures.
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Warnhinweise in Deutsch

Informational messages also appear throughout this manual. These are 
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They
alert you to an unexpected result of an action,
suggest how to optimize instrument performance,
etc.

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren
oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn
eine Situation zu schweren Schäden am Gerät führen kann, jedoch
keine Verletzungsgefahr besteht. 
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1.3.2 Safety Labels
The TUV GS, C, US Mark safety label and the CE Mark label on the 
ICS-90 indicate that the ICS-90 is in compliance with the following 
standards: EN 61010-1:2001 (safety), CAN/CSA-C22.2 No. 1010.1-
92+A2:97 (safety), UL 3101-1/10.93 (safety), and EN 
61326:1997+A1:1998 (EMC susceptibility and immunity).

The symbols below appear on the ICS-90 or on labels affixed to the 
ICS-90.

Alternating current

Protective conductor terminal

Power supply is on

Power supply is off

Indicates a potential hazard. Refer to the operator’s manual for 
an explanation of the hazard and how to proceed.
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2 • Description

The ICS-90 Ion Chromatography System (ICS-90) is designed for simplicity and 
ease of use. It is configured for optimal performance at the factory. ICS-90 
operation is controlled by Chromeleon or Chromeleon Xpress software. This 
chapter presents a brief description of key ICS-90 features and components and 
the software user interface.

Figure 2-1.  ICS-90 Ion Chromatography System

Status LEDs

Injection Port

Eluent 
Reservoir

Regenerant 
Reservoir
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2.1 Operating Features

2.1.1 Front Door and Top Cover
Figure 2-1 illustrates the front door and top cover of the ICS-90.

The front door contains a sample injection port and LEDs that indicate the 
ICS-90 operating status. The top cover is molded to hold the eluent and 
regenerant reservoirs.

LEDs

There are three status LEDs on the ICS-90 front 
panel. Other status information and alarm 
messages are displayed in the Audit Trail in 
Chromeleon or Chromeleon Xpress. See 
Section 4.1 for a description of these messages.

Injection Port

The sample to be analyzed is injected into the injection port, using either a 
syringe or the AS40 Automated Sampler. For more information about 
sample injection, see Section 3.5.6.

LED Label If On (Green) If Flashing

Power ICS-90 power is on Does not flash

Ready System check passed, but 
sequence not yet started 
(LED stays on until run starts 
or sequence is aborted)

System check failed (occurs if 
system check executes for 
10 minutes without success)

Run Running/acquiring data Error/alarm/fault (including 
injection valve position) 

Power

Ready

Run
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Eluent and Regenerant Reservoirs

The ICS-90 top cover is molded to hold one eluent reservoir assembly 
(P/N 057711) and one regenerant reservoir assembly (anion, P/N 057712; 
cation, P/N 057713).

• Eluent carries the sample through the ICS-90 and facilitates the ion 
separation process. The type of eluent used depends on the analyses 
performed. For example, an ICS-90 configured for anion analyses 
uses carbonate eluent, while an ICS-90 configured for cation analyses 
uses methanesulfonic acid (MSA) eluent.

• Regenerant “regenerates” the suppressor’s ability to suppress eluent 
conductivity. An ICS-90 configured for anion analyses uses dilute 
sulfuric acid regenerant. An ICS-90 configured for cation analyses 
uses tetrabutylammonium hydroxide (TBAOH) regenerant.
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2.1.2 Rear Panel
Figure 2-2 illustrates the ICS-90 rear panel.

Power Switch

The power switch provides on/off control of power to the ICS-90. 

Figure 2-2.  ICS-90 Rear Panel
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Main Power Receptacle

The AC power outlet is located directly below the power switch.

USB Port

The USB port provides a connection to the PC on which Chromeleon or 
Chromeleon Xpress is installed. For the standard system configuration of 
one ICS-90 connected to a PC, connect a USB cable between the USB 
connector on the ICS-90 and a USB port on the PC. See Section B.7.2 for 
detailed connection instructions.

Link LED

The Link LED indicates the communication status 
between the ICS-90 and the PC on which 
Chromeleon or Chromeleon Xpress is installed.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-90 and is easily
accessible.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.

LED Name Status Description

Link On A link has been established between the ICS-90 
and the PC, but no data is currently being 
transmitted or received

Flashing A link has been established between the ICS-90 
and the PC and data is being transmitted

Off No link between the ICS-90 and the PC has been 
established

Link
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TTL Output Connector

The TTL output connector allows an AS40 Automated Sampler to receive 
TTL signals from the ICS-90. See Section B.18 for instructions on how to 
connect the AS40 to the ICS-90.

Tubing Connections

Eight lines exit the ICS-90 from the lower left corner of the rear panel. 
These lines include: 

• 1 eluent line

• 1 regenerant line

• 1 cell outlet line

• 2 air lines

• 3 waste lines (sample, regenerant, and pump priming waste)
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2.1.3 Component Mounting Panel
Figure 2-3 shows the user-accessible components installed inside the 
ICS-90. The component panel is accessed by opening the front panel 
door. All of the components that the user can service are located on this 
panel.

DS5 Detection Stabilizer

The DS5 Detection Stabilizer (P/N 057290) houses a flow-through 
conductivity cell. Two 316 stainless steel electrodes are permanently 
sealed into the PEEK cell body. The cell measures the electrical 
conductance of analyte ions as they pass through the cell. 

Figure 2-3.  ICS-90 Component Mounting Panel

DS5 Detection
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Suppressor
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Temperature directly affects the conductivity of a solution. For example, 
laboratory heating and air conditioning systems can cause a regular slow 
cycling in the baseline. This, in turn, can affect the reproducibility of an 
analysis. The higher the conductivity, the more pronounced the effect.

In ion analysis, the effect of temperature variation is minimized by 
suppressing eluent conductivity. Built-in preset temperature 
compensation also ensures that there is no major change in the baseline or 
in peak heights. Temperature compensation further improves baseline 
stability.

Direct conductive heating is used in the ICS-90 to provide temperature 
control and compensation. A heat exchanger inside the ICS-90 cell 
regulates the temperature. All data is collected at 40 °C (104 °F).

Figure 2-4.  DS5 Detection Stabilizer

To ELUENT OUT port
on suppressor

regenerant reservoir
CELL OUT to 

Connector to component
 mounting panel

DS5 Detection Stabilizer
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MMS III Suppressor

The MMS III suppressor reduces the eluent conductivity and enhances the 
conductivity of the sample ions, thereby increasing detection sensitivity. 

As illustrated in Figure 2-5, a 
constant flow of regenerant 
over the membrane 
continually restores the 
suppression ability of the 
MMS III. 

A process called 
Displacement Chemical 
Regeneration (DCR) pushes 
regenerant from the 
regenerant reservoir and 
through the suppressor. See 
Section 2.2.1 for details.

For more information about 
the MMS III, see Installation 
Instructions and 
Troubleshooting Guide for 
the Anion MicroMembrane 
Suppressor® III (Document 
No. 031727) or Installation 
Instructions and 
Troubleshooting Guide for 
the Cation MicroMembrane 
Suppressor® III (Document 
No. 031728).

Figure 2-5.   MMS III Suppressor Flow

Suppressor manuals are included on the Dionex Reference Library CD-
ROM (P/N 055405).

Pressure Transducer

The pressure transducer measures the system pressure at the point that the 
eluent flows from the pump head outlet check valve into the pressure 
transducer. Pressure measurements, which can be monitored from 

REGEN OUT

ELUENT OUT

ELUENT IN

REGEN IN

Regenerant Screen

Ion Exchange Membrane

Ion Exchange Membrane

Regenerant Screen

Eluent Screen



ICS-90 Operator’s Manual

18 Doc. 031851-08 12/06

Chromeleon or Chromeleon Xpress, indicate that the pumping system is 
delivering smooth, accurate flow. Pressure limits are used to detect high 
or low pressure conditions that might require the pump to be shut down.

The system backpressure should remain consistent. A significant increase 
in backpressure indicates a blockage in the liquid lines. A significant 
decrease in backpressure may indicate leaks or decreased pump flow due 
to an unprimed pump or insufficient eluent. 

Injection Valve with Sample Loop

The injection valve is a six-port, electrically-activated Rheodyne valve. A 
10 μL sample loop (P/N 042949) is installed on the valve at the factory.

The valve has two operating positions: Load and Inject (see Figure 2-6). 
Eluent flows through either the Load or Inject path, depending on the 
valve position.

• In the Load position, sample is loaded into the sample loop, where it 
is held until injection. Eluent flows from the pump, through the valve, 
and to the column, bypassing the sample loop. Sample flows from the 
syringe or automated sampler line (if installed), through the valve, 
and into the sample loop. Excess sample flows out to waste.

• In the Inject position, sample is swept to the column for analysis. 
Eluent flows from the pump, through the sample loop, and on to the 
column, carrying the contents of the sample loop with it.

Figure 2-6.  Rheodyne Injection Valve Flow Schematics
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Pump

The ICS-90 uses a high-speed reciprocating pump with PEEK 
components. The flow rate can be set to between 0.0 and 5.0 mL/min. The 
recommended operating flow rate is between 0.5 and 2.0 mL/min.
Prime Valve

The prime valve is mounted on the pump head. The pump should be 
primed at installation and whenever the flow rate seems outside normal 
parameters. For priming instructions, see Section B.13.

Separator and Guard Columns

Both the separator and guard columns are packed with resin filling and 
perform the separation of the sample ions. However, the main function of 
the guard column is to absorb organic contaminants and remove 
particulates that might poison the separator column. 
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2.2 Fluid Schematic

Figure 2-7 shows the flow path through the ICS-90.

Liquid flows through the ICS-90 along the following flow path:

• Eluent from the eluent reservoir is pressurized by the gas, forced into the 
pump, and passes through the pressure transducer. From there, it is pushed 
through a pulse damper/restrictor assembly, which smooths minor pressure 
variations from the high-speed pump to minimize baseline noise. The eluent 
then flows into the injection valve.

• When sample is loaded into the sample loop, the injection valve toggles to the 
Inject position. This combines the injected sample with the eluent and pushes 
it through the sample loop. 

Figure 2-7.  ICS-90 Flow Schematic
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• The eluent/sample mixture is pumped through the guard and separator 
columns, where the ions are separated by the ion exchange process (that is, 
different sample ions migrate through the columns at different rates, 
depending upon their interactions with the ion exchange sites).

• The eluent/sample mixture flows through the suppressor. There, detection 
sensitivity is enhanced by suppressing the conductivity of the eluent and 
enhancing the conductivity of the analyte. Regenerant flows continuously 
through the suppressor, restoring the ion exchange sites to their original state.

• The eluent/sample mixture then flows through the DS5, where the analytes 
are detected and a signal is produced and sent to Chromeleon or Chromeleon 
Xpress software. 

• Finally, the eluent flows out of the cell and is directed into the regenerant 
reservoir, where it pressurizes the regenerant and forces it into the suppressor.

2.2.1 Displacement Chemical Regeneration (DCR)
Displacement Chemical Regeneration (DCR) is the process that 
regenerates the ability of the MMS III suppressor to suppress eluent. In 
DCR, the eluent/sample mixture that exits the cell is pumped into the 
regenerant reservoir. The eluent pressurizes the reservoir and pushes the 
regenerant into the suppressor. However, because the eluent is a different 
density than the regenerant, it remains separate. 

In the anion DCR process (see Figure 2-8), the eluent/sample mixture is 
lighter than the regenerant and it remains on the top, forcing the 
regenerant to the bottom of the reservoir and out into the suppressor. 

In the cation DCR process, the eluent/sample mixture is heavier than the 
regenerant and it flows to the bottom of the reservoir, displacing the 
regenerant and pushing regenerant out of the reservoir and into the 
suppressor. 
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Figure 2-8.  Anion ICS-90 Displacement Chemical Regeneration (DCR)
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2.3 Chromeleon and Chromeleon Xpress Software

2.3.1 Overview
The ICS-90 can be controlled by either Chromeleon Xpress or the 
Chromeleon Chromatography Management System.

• Chromeleon Xpress is a system controller that replaces and combines 
the front panels of all system modules into one centralized system 
Control panel, called a panel tabset. The ICS-90 tab provides access 
to ICS-90 functions, as well as to detailed status and diagnostics 
information for the system (see Figure 2-9).

• Chromeleon provides all of the system control features found in 
Chromeleon Xpress, plus complete data acquisition and data 
processing functions.

Figure 2-9.  ICS-90 Control Panel on the Panel Tabset
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Two modes of software control are available: direct control and automated 
control.

• With direct control, you select operating parameters and commands from 
Control panels or the Commands dialog box. (To open the Commands dialog 
box, press F8.) Direct control commands are executed as soon as they are 
entered. See Section 3.5.4 for details about direct control.

• With automated control, you create a program that contains a list of control 
commands, to be executed in chronological order, for automated operation of 
the detector. Programs (sometimes called PGM files) can be created 
automatically (with the help of a software wizard) or manually (by editing an 
existing program). See Section 3.5.5 for details about automated control.

2.3.2 System Wellness
System Wellness monitors the overall “health” of a chromatographic 
system. It provides built-in diagnostic and calibration features that help 
prevent unscheduled system shutdowns and assure reliable operation of 
system devices. 

You can perform diagnostic and calibration procedures and monitor 
ICS-90 functions from the Wellness panel (see Figure 5-1). In addition, 
all System Wellness parameters are available in the Commands dialog 
box.

For more information about System Wellness, refer to Section 5.1.
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3 • Operation and Maintenance

Operation of the ICS-90 Ion Chromatography System (ICS-90) is controlled 
through Chromeleon or Chromeleon Xpress software. However, three functions 
take place at the instrument:

• Eluent and regenerant preparation and/or reservoir installation

• On/off power control

• Manual sample or standard injection

The ICS-90 is designed for IC (ion chromatography) applications and should not 
be used for any other purpose. Operation of the ICS-90 in a manner not specified 
by Dionex may result in personal injury. 

3.1 Preparing the Eluent

For instructions on preparing the eluent, refer to the column manual. Column 
manuals are included on the Dionex Reference Library CD-ROM (P/N 055405).

3.2 Preparing the Regenerant

The type of regenerant used with the ICS-90 depends on the type of analysis to be 
run. A dilute sulfuric acid regenerant is used for anion analyses; a 
tetrabutylammonium hydroxide (TBAOH) regenerant is used for cation analyses. 
Follow the instructions below to prepare either anion or cation regenerant.

1. Fill the regenerant reservoir (anion, P/N 057712; cation, P/N 057713) about 
halfway with ASTM filtered, Type I (18-megohm) deionized (DI) water. 

For acid concentrates (such as the anion regenerant), always pour the
concentrate into deionized water, not into the empty reservoir.

Pour les concentrés acides (comme le régénérant anionique), versez
toujours le concentré dans de l'eau désionisée et non dans le
réservoir vide.
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2. Empty the entire bottle of concentrate into the reservoir.

3. Fill the concentrate bottle with DI water and empty the contents into the 
reservoir.

4. Continue to pour DI water into the reservoir until it is filled all the way to the 
top. If a few drops spill over, then it is full enough.

5. Insert the stopper assembly tubing into the reservoir and tighten the stopper. 

For additional information, refer to the Installation Instructions and 
Troubleshooting Guide for the Displacement Chemical Regeneration (DCR) Kit 
(Document No. 031664). The manual is included on the Dionex Reference 
Library CD-ROM (P/N 055405).

3.3 Pressurizing the Eluent Reservoir

1. Before beginning operation, verify that the clean gas supply is regulated to 
between 0.55 and 0.83 MPa (80 and 120 psi) and is connected to the gas inlet 
of the ICS-90 air regulator (see Figure 3-1). 

2. Verify that the gas line from the eluent reservoir is connected to the ICS-90 air 
regulator outlet line.

3. Make sure the eluent and regenerant reservoirs are filled, the caps are tightly 
screwed onto the reservoirs, and the lines connecting the eluent and 
regenerant reservoirs to the ICS-90 lines are securely connected. 

4. Pull out the air regulator knob and turn it clockwise to pressurize the eluent 
reservoir. 

5. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the regulator 
knob back in. 

Gießen Sie bei säurehaltigen Konzentraten (beispielsweise dem
Kationenelutionsmittel) das Konzentrat immer in entionisiertes
Wasser und nicht in den leeren Behälter.

The regenerant reservoir must be filled all the way to the top at all
times.

Do not shake the regenerant reservoir to mix the contents. The ICS-90
will stratify the contents.
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Do not pressurize the eluent reservoir above 70 kPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus.

Figure 3-1.  Reservoir Connections
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3.4 Preparing Samples

3.4.1 Collecting and Storing
Collect samples in high density polyethylene containers that have been 
thoroughly cleaned with deionized (DI) water. Do not clean containers 
with strong acids or detergents because these will leave traces of ions on 
the container walls. The ions may interfere with the analysis.

If samples will not be analyzed on the day they are collected, filter them 
through clean 0.45 μm filters immediately after collection; otherwise, 
bacteria in the samples may cause the ionic concentrations to change over 
time. Refrigerating the samples at 4 °C (39 °F) will reduce, but not 
eliminate, bacterial growth.

Analyze samples containing nitrite or sulfite as soon as possible. Nitrite 
oxidizes to nitrate, and sulfite to sulfate, thus increasing the measured 
concentrations of these ions in the sample. In general, samples that do not 
contain nitrite or sulfite can be refrigerated for at least one week with no 
significant changes in anion concentrations.

3.4.2 Pretreating
Analyze rainwater, drinking water, and air particulate leach solutions 
directly with no sample preparation (other than filtering and possibly 
diluting). 

Filter groundwater and wastewater samples through 0.45 μm filters 
before injection, unless samples were filtered after collection.

Before injection, pretreat samples that may contain high concentrations of 
interfering substances by putting them through Dionex OnGuard™ 
cartridges. For instructions, refer to Installation and Troubleshooting 
Guide for OnGuard Cartridges (Document No. 032943). The manual is 
included on the Dionex Reference Library CD-ROM (P/N 055405).

3.4.3 Diluting
Because the concentrations of ionic species in different samples can vary 
widely from sample to sample, no single dilution factor can be 
recommended for all samples of one type. In some cases (for example, 



3 • Operation and Maintenance

Doc. 031851-08 12/06 29

many water samples), concentrations are so low that dilution is not 
necessary.

Use eluent or ASTM filtered, Type I (18-megohm) deionized (DI) water 
to dilute the sample. When using carbonate eluents, diluting with eluent 
minimizes the effect of the water dip at the beginning of the 
chromatogram. If you dilute the sample with eluent, also use eluent from 
the same lot to prepare the calibration standards. This is most important 
for fluoride and chloride, which elute near the water dip.

To improve the accuracy of early eluting peak determinations, such as 
fluoride, at concentrations below 50 ppb, dilute standards in eluent or 
spike the samples with concentrated eluent to minimize the water dip. For 
example, spike a 100 mL sample with 1.0 mL of a 100 X eluent 
concentrate.

3.5 ICS-90 Operation

3.5.1 Starting Up the ICS-90
1. Make sure the eluent and regenerant reservoirs are filled, the caps are 

tightly screwed onto the reservoirs, and the lines connecting the 
reservoirs to the ICS-90 lines are securely connected (see Figure 3-1).

2. Make sure the clean gas inlet line is regulated to between 0.55 and 
0.83 MPa (80 and 120 psi), and is connected to the gas inlet of the 
ICS-90 air regulator (see Figure 3-1).

3. Make sure the gas line from the eluent reservoir is connected to the 
ICS-90 air regulator outlet line.

4. Make sure the air regulator is adjusted to between 30 and 40 kPa (5 
and 6 psi) (see Section 3.3).

5. Make sure the USB cable is connected to the USB port on the ICS-90 
rear panel. See Section B.4 for installation instructions.

6. Press the power switch on the ICS-90 rear panel (see Figure 2-2) to 
turn on the system power. These are the conditions at power-up:

• The pump is off. 

• The injection valve is in the Load position.

• The DS5 is reading its current value.
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3.5.2 Connecting to Chromeleon or Chromeleon Xpress
1. Turn on the computer. 

2. Start the Chromeleon Server, if it is not already running:

If the Chromeleon Server icon on the Windows taskbar is crossed out 

in red , the Server is not running. Start the Server by right-
clicking the icon and selecting Start Server. When the server is 

running, the icon is gray .

If the Server Monitor icon is not on the Windows taskbar, click Start 
on the taskbar and select All Programs (or Programs, depending on 
the operating system) > Chromeleon > Server Monitor. Click Start 
to start the server.

3. Start the Chromeleon client:

a. Click Start on the Windows taskbar and select All Programs (or 
Programs) > Chromeleon > Chromeleon to start the 
Chromeleon client.

b. If Chromeleon is installed, select View > Default Panel Tabset 

or click  on the toolbar to display the panel tabset.

NOTE If Chromeleon Xpress is installed, starting the
client automatically displays the panel tabset.

c. To display the ICS-90 (or ICS-90A) Control panel, select the 
ICS-90 tab on the panel tabset (see Figure 3-2). (The ICS-90A 
Control panel includes a Wellness Panel button; otherwise, the 
panels are identical.)



3 • Operation and Maintenance

Doc. 031851-08 12/06 31

4. Verify that the Connected check box is selected. If it is not, click the 
box to connect the ICS-90 to Chromeleon or Chromeleon Xpress.

5. Check the Control panel for the following:

• A steady operating pressure.

• The operating total conductivity background depends on the type 
of analysis to be performed. In general, it should be <30 μS for a 
system set up for anion analyses, and <2 μS for a system set up 
for cation analyses.

Figure 3-2.  ICS-90 Control Panel
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3.5.3 Preparing the ICS-90 for Operation
1. Turn on the pump by clicking the On button on the ICS-90 (or 

ICS-90A) Control panel in Chromeleon or Chromeleon Xpress (see 
Figure 3-2).

2. Prime the pump (for instructions, see Section B.13).

3. Allow the system to equilibrate for 30 minutes. During equilibration, 
the Control panel displays the background conductivity (the 
conductivity of the eluent before sample injection). Offset the 
background and zero the reading by clicking the Autozero button on 
the Control panel (see Figure 3-2).

NOTE If the ICS-90 pump is running but no data is
collected, the flow rate will remain constant
indefinitely. However, if the ICS-90 receives no
input from Chromeleon or Chromeleon Xpress (you
do not turn the pump on or off, run a sequence,
toggle the injection valve position, etc.) for 6 hours
after data is collected, the module enters standby
mode. In standby mode, the pump flow is reduced to
1/20th of its normal rate. To return to the normal
flow rate, either begin a new sequence or turn on the
pump from the Control panel. 

3.5.4 Manual Sample Processing
To manually process a sample, select operating parameters and 
commands from the Chromeleon or Chromeleon Xpress menu bar, 
toolbars, and Control panel. Commands are executed as soon as they are 
entered.

Summary of manual sample processing

1. Complete the steps in Sections 3.5.1, 3.5.2, and 3.5.3 to start the 
ICS-90, start Chromeleon or Chromeleon Xpress, and prepare the 
ICS-90 for operation.

2. Inject the sample via a syringe, vacuum syringe, or AS40 autosampler 
(see Section 3.5.6).

3. Click the Autozero button on the ICS-90 (or ICS-90A) Control panel.
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4. Select Control > Acquisition On. Chromeleon records the signal 
supplied by the detector and displays the signal plot on the Control 
panel.

5. To stop acquisition, select Control > Acquisition Off.
NOTES

• In Chromeleon, data from manual processing is saved in the 
MANUAL sequence folder under the local datasource. This data is 
overwritten each time a new manual sample is processed. To save 
the data from a manual run, select the MANUAL folder, select File 
> Save As, and enter a new name for the sequence.

• Chromeleon Xpress does not allow data to be saved.

3.5.5 Automatic Sample Processing
For automated control, you create a list of samples (a sequence) to be 
processed automatically. For each sample, the sequence includes a 
program with commands and parameters for controlling the ICS-90, 
acquiring sample data, and generating reports. Additional sample 
processing parameters are included in the sequence (for example, the 
sample name, sample type, injection volume, etc.). After the sequence has 
been defined, automatic sample processing (also called batch processing) 
is started.

Summary of automatic sample processing

1. Complete the steps in Sections 3.5.1, 3.5.2, and 3.5.3 to start the 
ICS-90, start Chromeleon or Chromeleon Xpress, and prepare the 
ICS-90 for operation.

2. Create a new control program or modify an existing one. 

To create a new program:

a. Select File > New. Select Program File and click OK. 

b. Complete the steps in the Program Wizard, selecting the desired 
processing options. For help with any of the steps, click the Help 
button on the Program Wizard page.
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3. Create a new sequence or modify an existing one.

To create a new sequence:

a. Select File > New. Select Sequence (using Wizard) and click 
OK. 

b. Complete the steps in the Sequence Wizard, adding the desired 
number of samples and standards to the list and specifying the 
control program created in Step 2. For help with any of the steps, 
click the Help button on the Sequence Wizard page.

4. To start the sample processing, select Batch > Edit.

5. Click the Add button on the Batch List tab and add the sequence you 
created in Step 3.

6. To start the batch, click the Start button.

Sample Processing Events (Default)

The following events occur if samples are processed using the default 
control program created with the Program Wizard:

• The pump is turned on.

• If an AS40 Automated Sampler is being used, the AS40 load cycle is 
started. If no autosampler is being used, the program pauses for you 
to manually load the sample into the sample loop.

• After the AS40 load cycle is complete—or after you manually load 
the sample—the background conductivity is offset from the total, 
thereby zeroing the baseline conductivity value. 

• The injection valve position is switched to the Inject position.

• Data acquisition is turned on.

• The injection valve returns to the Load position after 1 minute.

• Data acquisition is turned off after 30 minutes.



3 • Operation and Maintenance

Doc. 031851-08 12/06 35

3.5.6 Sample Injection
There are three ways to inject sample into the ICS-90: via syringe, 
vacuum syringe, or autosampler.

Injection via a Syringe

1. Make sure the injection port on the ICS-90 front door (see Figure 2-1) 
is connected to the sample port S (5) on the injection valve (see 
Figure 3-3).

2. Fill the 1 cc syringe (P/N 016388) provided in the ICS-90 Ship Kit 
(P/N 059947) with a calibration standard or sample.

3. Insert the syringe into the injection port on the ICS-90 front door.

4. Overfill the sample loop with several sample loop volumes. Excess 
sample will exit through the injection valve waste line.

5. Leave the syringe in the port.

6. Switch the injection valve to start the injection. The method used 
depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), click the 
Inject button on the ICS-90 (or ICS-90A) Control panel (see 
Figure 3-2). 

• For automatic sample processing (see Section 3.5.5), Chromeleon 
or Chromeleon Xpress pauses at the start of the program to allow 
you to load the sample loop (Step 1 through Step 4). After 
loading the loop, click OK. Chromeleon or Chromeleon Xpress 

Figure 3-3.  Injection Valve Connections
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automatically switches the injection valve position and continues 
running the program.

Injection via a Vacuum Syringe

1. Disconnect the waste line from port W (6) of the injection valve (see 
Figure 3-3) and attach a shorter line (10 to 12 inches of PEEK or 
Teflon® tubing).

2. Place the free end of the line into the sample.

3. Insert the 1 cc syringe (P/N 016388) provided in the ICS-90 Ship Kit 
(P/N 059947) into the injection port on the ICS-90 front door (see 
Figure 2-1) and pull the plunger out to “suck” the sample into the 
injection valve.

4. Switch the injection valve to start the injection. The method used 
depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), click the 
Inject button on the ICS-90 (or ICS-90A) Control panel (see 
Figure 3-2).

• For automatic sample processing (see Section 3.5.5), Chromeleon 
or Chromeleon Xpress pauses at the start of the program to allow 
you to load the sample loop (Step 1 through Step 3). After 
loading the loop, click OK. Chromeleon or Chromeleon Xpress 
automatically switches the injection valve position and continues 
running the program.

Injection via the AS40 Automated Sampler

1. Verify that the AS40 output line is connected to port S (5) of the 
ICS-90 injection valve, and the LOAD connector from the AS40 Relay 
Control cable is connected to the ICS-90 TTL Output connector on 
the rear panel. See Section B.18 for detailed installation instructions.

2. The injection process depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), load the 
injection valve sample loop as instructed in the AS40 Automated 
Sampler Operator’s Manual (Document No. 034970) included on 
the Dionex Reference Library CD-ROM (P/N 055405). Then, 
click the Inject button on the ICS-90 (or ICS-90A) Control panel 
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(see Figure 3-2) in Chromeleon or Chromeleon Xpress to start the 
injection.

• For automatic sample processing (see Section 3.5.5), the 
Chromeleon or Chromeleon Xpress program contains commands 
that start the AS40 sample load cycle and switch the ICS-90 
injection valve position.

3.6 Maintenance

This section describes routine maintenance procedures for the ICS-90 that users 
may perform. All other maintenance procedures must be performed by Dionex 
personnel.

As Needed
• Make fresh eluent as needed.

• Regularly check the eluent reservoir to see if it needs to be refilled.

• Whenever the eluent reservoir is refilled, the regenerant reservoir should also 
be emptied, rinsed, and refilled with regenerant.

Daily
• Check the ICS-90 component mounting panel (see Figure 2-3) for leaks or 

spills. Wipe up spills. Isolate and repair leaks (see Section 4.2). Rinse off any 
dried eluent or regenerant with deionized water.

• Check the waste container daily and empty when needed.

Weekly
• Once a week, check gas and fluid lines for crimping or discoloration. Relocate 

any pinched lines. Replace damaged lines.

• Check the junction between the pump head and the pump casting for evidence 
of liquid leaks. Normal friction and wear may gradually result in small liquid 
leaks around the piston seal. If unchecked, these leaks can gradually 
contaminate the piston housing, causing the pump to operate poorly. If leaks 
occur, replace the piston seals (see Section 5.6).
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Yearly
• Change the pump seals (see Section 5.6).

• Rebuild the injection valve (see Section 5.9).

• Replace the AS40 Automated Sampler tip and tubing. The ASM/AS40 
Sample Tip Replacement Kit (P/N 040835) contains all of the components 
required to replace the sampling tip and the tubing between the tip and the 
injection valve. For instructions on how to replace the sampling tip, see the 
AS40 Automated Sampler Operator’s Manual (Document No. 034970). The 
manual is included on the Dionex Reference Library CD-ROM (P/N 055405).
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4 • Troubleshooting

This chapter is a guide to troubleshooting problems that may occur while 
operating the ICS-90 Ion Chromatography System (ICS-90). 

• Section 4.1 describes the error messages displayed in the Chromeleon or 
Chromeleon Xpress Audit Trail. 

• Section 4.2 through Section 4.13 describe other operating problems and how 
to resolve them.

If you are unable to eliminate a problem, contact Dionex for help. In the U.S., call 
Dionex Technical Support at 1-800-346-6390. Outside the U.S., call the nearest 
Dionex office.

4.1 Alarms and Error Conditions

If any of the following alarm conditions occurs, an error message is displayed in 
the Chromeleon or Chromeleon Xpress Audit Trail. Each error message is 
preceded by an icon that identifies the seriousness of the underlying problem (see 
the table below). You can change the severity level assigned to a problem 
whenever appropriate.

Icon Severity Level Description
Warning A message is displayed in the Audit Trail, but the 

current run is not interrupted.

 Error A message is displayed in the Audit Trail and the 
system attempts to correct the problem (sometimes 
by using an alternative parameter). An Error never 
interrupts the current analysis; however, if it occurs 
during the Ready Check, the analysis will not be 
started.

Abort A message is displayed in the Audit Trail and the 
running batch is aborted.
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• PUMP OVER PRESSURE ALARM

The ICS-90 has a maximum system pressure limit of 28 MPa (4000 psi). In 
addition, the pressure limit can be lowered from Chromeleon or Chromeleon 
Xpress (in the Server Configuration or in the control program). If the system 
pressure exceeds the set limit for at least 0.5 second, Chromeleon or 
Chromeleon Xpress will stop the pump and the following error message will 
appear in the Audit Trail:

To troubleshoot:

1. Check for blockages in the liquid lines by working your way 
backward from the cell to the pump (see Figure 2-7 for the flow 
schematic). 

2. Restart the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

• PUMP UNDER PRESSURE ALARM 

The system pressure has fallen below the low pressure limit, which is set from 
Chromeleon or Chromeleon Xpress (in the Server Configuration or in the 
control program). Chromeleon or Chromeleon Xpress will stop the pump and 
display the following error message in the Audit Trail:

To troubleshoot:

1. Make sure the eluent reservoir is full.

2. Check for liquid leaks (see Section 4.2).

3. Prime the pump (see Section B.13).

4. Restart the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

The system pressure has exceeded the limit.

The pump has lost prime.
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• LOAD/INJECT VALVE ERROR

If the injection valve fails to switch positions within 1 second of being 
toggled, the ICS-90 Moduleware will report an error to Chromeleon or 
Chromeleon Xpress and the following error message will be displayed in the 
Audit Trail:

To troubleshoot:

1. If a sequence is being executed, terminate the sequence by selecting 
Stop from the Batch menu.

2. Turn off the ICS-90 power briefly and then restart.

3. Try to toggle the valve from Load to Inject by clicking the Inject 
button on the ICS-90 (or ICS-90A) Control panel in Chromeleon or 
Chromeleon Xpress. 

4. If the problem persists, call Dionex for assistance.

• OVER CONDUCTIVITY

This message usually appears for the first few minutes after the ICS-90 is 
started. If the message appears at other times, it indicates a problem.

To troubleshoot:

1. Perform the suppressor QuickStart procedure:

a. Disconnect the separator column outlet line and connect it to the 
DS5 cell inlet line.

b. Turn on the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress and allow the suppressor to 
regenerate for 5 minutes.

c. Turn off the pump and allow the suppressor to hydrate for 
5 minutes.

d. Reconnect the separator column outlet line and cell inlet line. 

Load/inject valve error.

Conductivity exceeds limit.
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2. If the high background persists:

• Prepare fresh eluent (see Section 3.1).

• Prepare fresh regenerant (see Section 3.2).

• Verify the cell calibration by pumping deionized water through 
the cell (bypassing the column(s) and suppressor). The total 
background should be less than 1.0 μS.

• Perform the suppressor off-line regeneration procedure. For 
instructions, refer to the suppressor manual. Suppressor manuals 
are included on the Dionex Reference Library CD-ROM (P/N 
055405).

• If the problem persists, replace the suppressor (see Section 5.11).

• DATA BUFFER OVERFLOW ERROR

Various electronics-related problems can cause the following error message to 
be displayed in the Audit Trail:

If this warning appears, call Dionex for assistance. The ICS-90 
electronics components cannot be serviced by the user. 

4.2 Liquid Leaks

• Leaking fitting

Locate the source of the leak. Tighten or, if necessary, replace the liquid line 
connection (see Section 5.2). Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for tightening requirements. The manual is 
included on the Dionex Reference Library CD-ROM (P/N 055405).

• Broken liquid line

Replace the line and fittings (see Section 5.2).

• Blocked or improperly installed line

Make sure the lines are not crimped or otherwise blocked. Also, if the blocked 
line is a waste line, make sure it is not elevated at any point after it exits the 
ICS-90. If a line is blocked, replace it (see Section 5.2).

Module data buffer overflow. Data may have been lost.



4 • Troubleshooting

Doc. 031851-08 12/06 43

• Loose pump check valve housing

Make sure the check valves are firmly seated in the pump head. If they are 
not, tighten them carefully with an open-end wrench just until the leak stops.

• Damaged pump piston seal

1. Replace the piston seal (see Section 5.6).

2. If the problem persists, replace the piston (see Section 5.7).

• Pump head not tight against casting

Carefully tighten the pump head mounting nuts just until the leak stops. DO 
NOT OVERTIGHTEN!

• Leaking pressure transducer

Make sure the liquid line connections into the pressure transducer are tight. 
Refer to Installation of Dionex Liquid Line Fittings (Document No. 031432), 
included on the Dionex Reference Library CD-ROM (P/N 055405), for 
tightening requirements. Replace any damaged fittings.

• Leaking pump head waste valve

Make sure the waste valve is closed. To close the valve, turn the knob 
clockwise, just until tight. DO NOT OVERTIGHTEN! Overtightening 
may damage the valve and the pump head.

Inspect the pump head. If the waste valve is the source of the leak, replace the 
waste valve O-ring (see Section 5.8). 

• Leaking MMS III

Refer to the suppressor manual for troubleshooting procedures. Suppressor 
manuals are included on the Dionex Reference Library CD-ROM 
(P/N 055405).

• Leaking injection valve

Make sure the liquid line connections to the transducer are tight. Replace any 
damaged fittings. Refer to Installation of Dionex Liquid Line Fittings 
(Document No. 031432) for tightening requirements. The manual is included 
on the Dionex Reference Library CD-ROM (P/N 055405).

Liquid leaks from behind the valve stator may indicate a scratched rotor seal. 
Rebuild the injection valve (see Section 5.9).
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• Leaking DS5 Detection Stabilizer 

Check the waste lines for blockage; trapped particles can plug the lines and 
cause a restriction and/or leak. If necessary, clear the waste lines by reversing 
the direction of flow.

Make sure the plumbing downstream from the cell is clear; a blockage may 
overpressurize the cell, causing it to leak. If the problem continues, contact 
Dionex for assistance.

4.3 Pump Difficult to Prime or Loses Prime

• Empty eluent reservoir and/or no eluent connected

Fill the reservoir. Make sure all connections are secure. 

• Eluent reservoir not pressurized

Make sure the gas line is properly connected between the air regulator and the 
reservoir, and that the inlet gas supply is regulated to between 0.55 and 
0.83 MPa (80 and 120 psi) and connected to the air regulator. Make sure the 
eluent reservoir cap is screwed on tightly. See Section B.9 and Section B.10 
for detailed connection instructions. 

• Dirty check valve

Clean and/or replace the pump check valve (see Section 5.5).

• Liquid leaks at junction between pump head and pump casting

Replace the piston seal (see Section 5.6).

4.4 Pump Does Not Start

• No power (front door Power LED indicator fails to light)

Check that the power cord is plugged in.

Check the main power fuses and replace if needed (see Section 5.12).

• No communication between ICS-90 and Chromeleon or Chromeleon 
Xpress (Link LED on rear panel fails to light)

The USB cable is not connected correctly. See Section B.4 for installation 
instructions.
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4.5 No Flow

• Pump not primed

Prime the pump (see Section B.13).

• Broken pump piston

Replace the piston (see Section 5.7).

4.6 Erratic Flow

• Pump needs priming

Prime the pump (see Section B.13).

• Damaged piston seal

Replace the piston seal (see Section 5.6).

• Dirty pump check valve

Clean or replace the check valve (see Section 5.5).

4.7 Excessive System Backpressure

• Restriction in the system plumbing

Check all liquid lines for crimping or blockage. Make sure the ferrule fittings 
are not overtightened onto tubing. Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for details. The manual is included on the 
Dionex Reference Library CD-ROM (P/N 055405).

• Plugged or damaged fitting

Isolate the faulty fitting by loosening fittings, one by one, until the pressure 
returns to normal. Repair or replace the fitting (see Section 5.2).

• Flow rate through the columns too high

Measure the pump flow rate and set it to the correct rate (see Section B.14).
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• Clogged column bed supports

Refer to the instructions in the column manual for troubleshooting guidance. 
Column manuals are included on the Dionex Reference Library CD-ROM 
(P/N 055405).

• Contaminated columns

Clean the columns as instructed in the column manual. Column manuals are 
included on the Dionex Reference Library CD-ROM (P/N 055405).

• Plugged Rheodyne valve passages

Rebuild the injection valve (see Section 5.9).

4.8 Peak “Ghosting” 

Ghosting is the appearance of extraneous peaks in a chromatogram. These may be 
late-eluting peaks from a previous injection or they may result from a 
contaminated, malfunctioning, or incorrectly installed injection valve. These 
peaks may co-elute with peaks of interest, resulting in nonreproducible peak 
heights/areas.

• Insufficient time between sample injections

Wait until the previous sample has been completely eluted before making 
another injection. 

• Insufficient flush between samples

Flush the sample loop with at least 10 loop volumes of deionized water or 
sample between sample injections.

• Incorrect or contaminated standards

Remake standards.

• Incorrect or contaminated eluent

Remake the eluent (see Section 3.1).

• Malfunctioning injection valve

Contact Dionex for assistance.
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4.9 Nonreproducible Peak Height or Retention Time

• Column overloading

Dilute the sample (see Section 3.4.3).

• Liquid leaks

Locate and eliminate the leaks (see Section 4.2). 

• Incomplete or imprecise filling of the sample loop

1. Fill the sample loop until excess sample exits the waste line.

2. Inspect the 1 cc syringe (P/N 016388) and replace if damaged.

• Pump not primed properly

Prime the pump (see Section B.13).

4.10 Abnormal Retention Time or Selectivity

• Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water (see Section 3.1).

• Contaminated or degraded sample

Take appropriate precautions when preparing and storing samples to prevent 
contamination and degradation (see Section 3.4).

• Contaminated column

1. Clean the column as instructed in the column manual. Column manuals 
are included on the Dionex Reference Library CD-ROM (P/N 055405), 
located in the ICS-90 Ship Kit (P/N 059947).

2. If cleaning is unsuccessful, replace the column.
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4.11 No DS5 Response

• DS5 not properly installed

Check that the DS5 is plugged into the component mounting panel and 
screwed down until the bottom of the DS5 is flush against the sheet metal 
panel (see Figure 2-3 and Figure 2-4).

• No flow from pump

Several conditions may cause this condition; see Section 4.4 and Section 4.5 
for details.

• Cell electronics malfunctioning

Use the Chromeleon or Chromeleon Xpress Wellness panel diagnostics to test 
the electronics with a dummy cell (see Section 5.1 and the online Help for 
instructions). If the variance reading is outside the tolerance range (less than 
1 μS), the electronics are malfunctioning. Call Dionex for assistance.

4.12 High DS5 Output

• Background not suppressed by suppressor

If Conductivity exceeds limit is displayed in the Chromeleon or Chromeleon 
Xpress Audit Trail, follow the instructions in Section 4.1. For additional 
troubleshooting guidance, refer to the suppressor manual. Suppressor manuals 
are included on the Dionex Reference Library CD-ROM (P/N 055405).

• Sample concentration too high

Dilute the sample (see Section 3.4.3).

• Wrong eluent or regenerant

Check that you are using the correct eluent and regenerant for your system 
(see Section 3.1).

• Cell out of calibration

Recalibrate the cell from the Wellness panel in Chromeleon or Chromeleon 
Xpress (see Section 5.1).
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4.13 Baseline Noise or Drift

• Flow system leak; erratic baseline

Check all fittings and liquid lines for leaks. Tighten or, if necessary, replace 
all liquid line connections. Refer to Installation of Dionex Liquid Line Fittings 
(Document No. 031432) for tightening requirements. The manual is included 
on the Dionex Reference Library CD-ROM (P/N 055405).

• Trapped gases

Release any trapped gases in the cell by loosening the lines to and from the 
cell and then retightening them. Also loosen and retighten the fittings to and 
from the MMS eluent ports.

• Pump not properly primed

Prime the pump (see Section B.13).

• Contaminated or incorrect eluent and/or regenerant

Remake the eluent and regenerant (see Section 3.1).

• Rapid changes in ambient temperature

If the ambient temperature does not meet the specification of 10 to 35 °C (50 
to 95 °F), verify that air conditioning and heating vents are directed away 
from the ICS-90 and the ICS-90 front door is closed.

• Insufficient system equilibration following changes to operating 
parameters; especially apparent when operating at high sensitivities

Allow a longer system equilibration time (up to 2 hours) before starting 
operation.

• Incorrect suppressor operating conditions

Refer to the suppressor manual for troubleshooting information. Suppressor 
manuals are included on the Dionex Reference Library CD-ROM 
(P/N 055405).

• Cell above or below temperature

Call Dionex for assistance.

• Damaged piston seal

Replace the piston seal (see Section 5.6).
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• DCR backpressure tubing not installed

Install the tubing on the end of the suppressor waste line (see Section B.8).
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5 • Service

This chapter describes routine service procedures for the ICS-90 Ion 
Chromatography System (ICS-90) that users may perform. Other service 
procedures must be performed by Dionex personnel.

NOTE The ICS-90 electronics components cannot be serviced
by the user. Repair of electronics components must be
performed by Dionex personnel.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to 
isolate the cause of the problem. When ordering replacement parts, please include 
the ICS-90 model number and serial number. To contact Dionex in the U.S., call 
1-800-346-6390. Outside the U.S., call the nearest Dionex office.

5.1 Diagnostics and Calibrations

Chromeleon and Chromeleon Xpress allow you to monitor ICS-90 functions and 
perform diagnostic and calibration procedures from the Wellness panel (see 
Figure 5-1). This section provides an overview of Wellness panel features. For 
instructions on performing calibrations, see the following sections:

• Calibrating the Pressure Transducer (Section 5.1.1)

• Calibrating the Cell (Section 5.1.2)

• Calibrating the Flow Rate (ICS-90A only) (see Section 5.1.3)

NOTE If you are unsure whether your system is an ICS-90 or
ICS-90A, check the model data label on the rear panel.

To open the Wellness panel:
1. In the Chromeleon Browser, expand the Dionex Templates folder, and then 

the Panels and the Wellness folders.

Substituting non-Dionex parts may impair the performance of the
ICS-90, thereby voiding the product warranty. Refer to the warranty
statement in the Dionex Terms and Conditions for more information.
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2. In the right pane of the Browser window, double-click either Dionex_ICS-
90_wellness.pan or Dionex_ICS-90A_wellness.pan.

Note: You can also open the ICS-90A Wellness panel by double-clicking the 
Wellness Panel button on the ICS-90A Control panel in Chromeleon or 
Chromeleon Xpress.

The selected Wellness panel appears. The ICS-90A version of the panel (see 
Figure 5-1) includes controls for flow rate calibration that are not available on 
the ICS-90 Wellness panel; otherwise, the panels are identical.

Figure 5-1.  ICS-90 Wellness Panel (ICS-90A version shown)

Use the Wellness panel to monitor and/or perform the following functions:

System Status • The check box to the left of the ICS-90 LED indicates the 
connectivity status. When the check box is gray, there is no 
connectivity between the ICS-90 and the Chromeleon or 
Chromeleon Xpress computer.

• The ICS-90 serial number is displayed to the right of the 
ICS-90 LED.

• While a calibration or diagnostic procedure is running, the 
Calibration or Diagnostic box is green.
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Audit Trail • The Audit Trail displays an account of every event that 
occurs during ICS-90 operation. This includes errors, status 
messages, operational events, etc.

System • The current total system Pressure is displayed.

• The current electrochemical detector (ECD) conductivity is 
displayed.

Calibration • Pressure Transducer
• The offset, slope, and date of the last calibration are 

displayed.

• The Measured field is in the slope calibration. See 
Section 5.1.1 for instructions.

• The Calibrate Offset and Calibrate Slope buttons 
are used to calibrate the pressure transducer. See 
Section 5.1.1 for instructions.

• Conductivity Cell
• The offset, slope, and date of the last DS5 calibration 

are displayed.

• The Calibrate Offset or Calibrate Slope buttons are 
used to calibrate the cell. See Section 5.1.2 for 
calibration instructions.

• Flow Rate
• The offset and date of the last calibration are displayed.

• The Calibrate Offset button is used to calibrate the 
flow rate. See Section 5.1.3 for calibration instructions.

• Click the Details button to open a window that shows the 
factory-set calibration values, the current values, and the 
previous set of calibration values. The factory and last set of 
calibration values can be downloaded from this window.

Diagnostic • The last calibrated pressure and conductivity variance, 
minimum, and maximum readings for the DS5 are 
displayed.

• The Start and Stop buttons start and stop the readings.

• To determine the conductivity variance of the electronics 
alone, select the Dummy Cell box and then click Start. The 
variance reading should be less than 1 μS.
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5.1.1 Calibrating the Pressure Transducer

NOTE About 10 minutes before starting this calibration
procedure, toggle the injection valve position a few times
by clicking the valve Load and Inject buttons on the
ICS-90 (or ICS-90A) Control panel in Chromeleon or
Chromeleon Xpress. This removes any air or
contaminant buildup in the injection valve loop.

1. Turn off the pump flow from the ICS-90 (or ICS-90A) Control panel.

2. Open the waste valve on the front of the pump head (see Figure 5-2) 
by turning the knob counterclockwise two turns.

3. Open the ICS-90 (or ICS-90A) Wellness panel (see Section 5.1).

4. Click the Calibrate Offset command button under pressure 
transducer (see Figure 5-1). The pump calibrates the transducer and 
uploads the new value to Chromeleon or Chromeleon Xpress. The 
new offset is stored as the current value.

5. Close the waste valve.

Figure 5-2.  ICS-90 Interior Components

Pressure
Transducer

Pump Head
Waste Valve

DS5 Detection
Stabilizer
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6. Connect a pressure gauge between the pump outlet and the pressure 
transducer (see Figure 5-2). Turn on the pump and let the system 
stabilize. Note the average pressure reading on the gauge; enter this 
reading in the measured field.

7. Click the Calibrate Slope command button under pressure 
transducer. The pump calibrates the slope and uploads the new value 
to Chromeleon or Chromeleon Xpress. The new slope is stored as the 
current value.

8. Turn off the pump.

9. Disconnect the pressure gauge. Reconnect the pressure transducer to 
the pump.

5.1.2 Calibrating the Cell
Calibrate the cell every 6 months or after installing a new DS5 Detection 
Stabilizer.

1. Open the ICS-90 (or ICS-90A) Wellness panel (see Section 5.1).

2. Use an Allen wrench to remove the two screws securing the DS5 to 
the ICS-90 component mounting panel (see Figure 5-2). Save the 
screws.

3. Pull the DS5 straight out from the component mounting panel to 
unplug the cell from its electronics. Let the DS5 hang by the tubing.

4. Allow the conductivity to stabilize for 5 to 10 minutes.

5. Click the Calibrate Offset command button under conductivity cell 
(see Figure 5-1).

6. Line up the 9-pin connectors on the DS5 and the component 
mounting panel and plug the DS5 back into the electronics. Replace 
the mounting screws (removed in Step 2) and tighten.

Items Needed Description

1.0 mM KCl solution Prepare by dissolving 0.07456 g of reagent-
grade KCl in one liter of 18-megohm DI 
water.

Backpressure tubing to provide 
at least 7 MPa (1000 psi)

Use 0.076-mm (0.003-in) ID yellow PEEK 
tubing (P/N 049715).
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7. Disconnect the pump outlet line from port P (2) on the injection 
valve; connect the line directly to the cell inlet, using the yellow 
PEEK backpressure tubing (P/N 049715).

8. Fill an eluent bottle with 1.0 mM KCl solution and connect it to the 
eluent out line. Prime the pump (see Section B.13) and then turn on 
the pump.

9. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.

10. Allow the conductivity to stabilize for 5 to 10 minutes. 

11. Click the Calibrate Slope command button under conductivity cell. 
The cell is calibrated and a new cell calibration constant is uploaded 
to Chromeleon or Chromeleon Xpress. The new value is stored as the 
current cell calibration constant. 

After calibration, the conductivity reading should be 147.00 ± 
2 μS/cm. If this is not the case, call Dionex for assistance.

12. Flush the KCl solution from the system by pumping DI water through 
the cell. When the conductivity drops to near zero, stop the pump 
flow.

13. Reconnect the pump to the injection valve and reconnect the line 
from the suppressor to the cell inlet.

5.1.3 Calibrating the Flow Rate (ICS-90A only)

NOTE If you typically operate the ICS-90A at a particular flow
rate, you may wish to calibrate the system at that flow
rate to improve flow rate accuracy.

1. Measure the flow rate, using one of the methods described below:

• Volumetrically (recommended for most applications): Measure 
the volume of liquid collected over a measured time period (see 
page 57 or page 58).

• Gravimetrically: Weigh the mass of liquid collected over a 
measured time period (see page 58). The gravimetric method is 
slightly more accurate than the volumetric method.

2. After measuring the flow rate, go on to page 59 to calibrate the flow 
rate.
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Volumetric Method 1 (Recommended): Using a Syringe and Adapter

1. Locate the following items in the ICS-90 Ship Kit (P/N 059947): luer 
fitting (P/N 024305), luer coupler (P/N 042806), 1 mL syringe 
(P/N 016388), and 10 mL syringe (P/N 016387). You will also need a 
stopwatch or a clock or watch with a second hand (the computer’s 
clock can be used), and a small beaker or other container for 
collecting waste.

2. Connect the luer coupler to the luer fitting. 

3. Select the syringe to be used: 

• For a flow rate of 0.5 mL/min, use the 1 mL syringe.

• For a flow rate above 0.5 mL/min, use the 10 mL syringe.

4. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. Connect the luer coupler to the ELUENT IN line, and 
connect the syringe to the luer fitting (see Figure 5-3).

5. Using a stopwatch or clock’s second hand, time the flow of eluent 
into the syringe for 60 seconds. Determine the volume collected by 
noting the beginning and ending positions of the syringe plunger. 

6. The volume of eluent collected in 60 seconds should be 
approximately equal to the desired flow rate in milliliters per minute. 
For example, for a flow rate of 1 mL/min, the volume should be 1.0 ± 
0.1 mL.

Figure 5-3.  Assembled Syringe and Luer Adapter

Luer 
Fitting

Eluent In 
Line

Luer 
Coupler

Syringe
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7. If necessary, adjust the flow rate knob, and then repeat the 
measurement. Continue adjusting until the desired milliliters per 
minute is collected.

8. Reconnect the ELUENT IN line to the suppressor.

Volumetric Method 2: Using a Graduated Cylinder

1. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

2. Using a clock or watch with a second hand (the computer’s clock can 
be used), collect eluent from the ELUENT IN line into a small 
graduated cylinder for 2 minutes.

3. The collected eluent should be approximately equal to the desired 
flow rate in milliliters per minute. For example, for a flow rate of 1 
mL/min, 2.0 ± 0.2 mL should be collected in 2 minutes.

4. If necessary, adjust the flow rate knob, and then repeat the 
measurement. Continue adjustments until the desired eluent per 
minute is collected.

5. Reconnect the ELUENT IN line to the suppressor.

Gravimetric Method

1. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

2. Using a tared beaker and a calibrated stopwatch, collect the eluent 
from the ELUENT IN line for 60 seconds.

3. Weigh the mass of the eluent. The mass (in grams) should be 
approximately equal to the desired flow rate in milliliters per minute. 
For example, for a flow rate of 0.5 mL/min, the mass of the collected 
eluent should be 0.5 ± 0.02 g.

4. If necessary, adjust the flow rate knob, and then repeat Step 2 and 
Step 3. Continue adjusting until the desired mass per minute is 
collected.

5. Reconnect the ELUENT IN line to the suppressor.
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Calibrating the Flow Rate

1. Open the ICS-90A Wellness panel (see Section 5.1).

2. Enter the flow rate obtained by the volumetric or gravimetric method 
in the measured field.

3. Click the Calibrate Offset command button under flow rate (see 
Figure 5-1). The pump calibrates the flow rate and uploads the new 
value to Chromeleon or Chromeleon Xpress. The new offset is stored 
as the current value.

5.2 Replacing Tubing and Fittings

The ICS-90 is plumbed with the tubing and tubing assemblies listed below.

• 10-32 fittings (P/N 043275) and ferrules (P/N 043276) are used for most 
tubing connections. For tightening requirements, refer to Installation of 
Dionex Liquid Line Fittings (Document No. 031432). The manual is included 
on the Dionex Reference Library CD-ROM (P/N 055405).

• 1/8-in fittings (P/N 052267) and ferrules (P/N 048949) are used for 
connections to the MMS III REGEN OUT port and the eluent and regenerant 
reservoirs.

• 1/16-in fittings (P/N 052230) and ferrules (P/N 052231) are used for 
connections from the injection port to the injection valve.

Tubing Size and Type Used For

0.125-mm (0.005-in) ID PEEK 
(P/N 044221) 

Connection from pump pulse damper to 
injection valve

0.25-mm (0.010-in) ID PEEK 
(P/N 042690) 

Connections between other system 
components

0.30-mm (0.012-in) ID Tefzel® 
(P/N 048904)

Connection from injection port to injection 
valve

0.75-mm (0.030-in) ID PEEK 
(P/N 044777)

Connection from injection valve to waste and 
between the DS5 and regenerant reservoir



ICS-90 Operator’s Manual

60 Doc. 031851-08 12/06

5.3 Changing the Sample Loop

Figure 5-4 shows the injection valve connections. The injection valve is plumbed 
at the factory with all tubing and fittings for connection to the pump, injection 
port, and column. A 10 μL PEEK sample loop (P/N 042949) is installed at the 
factory between ports L and L. Always replace the pre-installed 10 μL loop with 
another of the same size. 

1. Turn off the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

2. Open the ICS-90 front door.

3. Disconnect the sample loop from ports L and L on the injection valve (see 
Figure 5-4).

4. Install the new sample loop between ports L and L on the injection valve.

5. Make sure the loop is tightly coiled so the door can close securely.

6. Close the door.

7. Turn on the pump from the Control panel.

Figure 5-4.  Injection Valve Plumbing
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5.4 Isolating a Restriction in the Liquid Plumbing

A restriction in the liquid plumbing will cause excessive system backpressure.

1. Begin pumping eluent through the system (including the columns).

2. Follow the ICS-90 flow schematic (see Figure 2-7) and work backward 
through the system, beginning at the cell exit. One at a time, loosen each 
fitting and observe the pressure. The connection at which the pressure drops 
abnormally indicates the point of restriction.

If the restriction has caused such high pressure that the system cannot be 
operated, you must work forward through the flow schematic, adding parts 
one at a time until an abnormal pressure increase (and hence, the restriction) is 
found.

3. If the restriction is in the tubing or fitting, remove the restriction by back 
flushing or by replacing the tubing or fitting.

5.5 Cleaning and Replacing Pump Check Valves

A dirty check valve causes an erratic flow rate. It may also cause the pump to lose 
prime and/or be difficult to reprime.

1. Prime the pump (see Section B.13). If the pump does not stay primed, go to 
the next step.

2. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

3. Open the front door of the ICS-90.

4. Disconnect the tube fittings from both the inlet and outlet pump check valve 
housings (see Figure 5-5).

5. Using a 1/2-in box wrench or an adjustable wrench, carefully remove both 
check valve housings from the pump head.

6. Place the check valves in a beaker of methanol and sonicate or agitate for 
several minutes.

7. Rinse each check valve thoroughly with filtered, deionized water.
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8. Reinstall the check valves in the pump head. Be sure to install the inlet check 
valve (which a 1/4-28 port) on the bottom of the head and the outlet check 
valve (which has a 10-32 port) on the top. Tighten only enough to seat. 

9. Reconnect the liquid lines. Close the front door. 

10. Reconnect the power cord, and turn on the power switch on the ICS-90.

11. Prime the pump (see Section B.13). If the pump will not prime, and you have 
eliminated all other possible causes of the problem, replace both check valves 
(inlet check valve, P/N 047660; outlet check valve, P/N 047661).

Figure 5-5.  Pump Head Assembly

Overtightening may damage the pump head or the check valve
housing and crush the check valve seats.
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5.6 Replacing a Pump Piston Seal

A damaged piston seal allows leakage around the piston at the head mounting 
plate or around the base of the pump head. Flow rates will be unstable and there 
may be baseline noise.

1. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

2. Open the ICS-90 front door.

3. Disconnect the tube fittings from the inlet and outlet check valves (see 
Figure 5-5).

4. Hold the head firmly against the pump housing, to compensate for the spring 
loading, and remove the two nuts (see Figure 5-6).

Lateral motion when disengaging the head from the piston can break
the piston.

Un mouvement latéral pendant la séparation de la tête et du piston
peut casser le piston.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf vom Kolben
lösen. Andernfalls kann der Kolben brechen. 

Figure 5-6.  Removing the Pump Head



ICS-90 Operator’s Manual

64 Doc. 031851-08 12/06

5. Slowly release the head, allowing it to separate from the housing. 
CAREFULLY disengage the head from the sapphire piston by pulling the 
head straight off and away from the mounting guides (see Figure 5-6). Be 
especially careful not to snap the piston if the internal spring sticks to the 
piston guide. 

6. Place the head, front end down, on a clean work area. Lift off the piston guide 
and back-up washer to expose the seal (see Figure 5-7).

7. Remove the piston seal from the head. Discard the seal.

8. Remove the O-ring and back-up seal from the back-up washer.

9. Carefully push the new piston seal (P/N 055870) into the head. When 
properly installed, the piston seal is almost flush with the indented surface of 
the head.

10. Press a new back-up seal (P/N 036901) into the O-ring (P/N 035776). If 
necessary, also replace the O-ring. Then, press the O-ring and back-up seal 
into the back-up washer assembly (P/N 057233).

11. Press the back-up washer assembly into the head, followed by the piston 
guide (P/N 035030).

12. Remove the spring, spring guide, piston, spring retainer, and retainer ring 
from the pump housing (see Figure 5-8). Inspect the interior of the housing 
for liquid and corrosion. Clean up any spills and carefully clean any signs of 
corrosion from the interior of the housing. 

Figure 5-7.  Pump Head Assembly
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13. Clean and inspect the piston. If it is scored or scratched, replace it (see 
Section 5.7).

14. Reinstall the retainer ring, spring retainer, piston, spring guide, and spring in 
the pump housing.

15. Carefully slide the pump head straight onto the mounting guides. Guide the 
spring onto the piston guide. Apply gentle pressure to push the piston through 
the seal.

16. Hold the head firmly against the pump housing and replace the two nuts. Use 
a wrench to tighten them evenly.

17. Reconnect the liquid lines to the inlet and outlet check valves on the pump 
head assembly (see Figure 5-5).

18. Reconnect the power cord and turn on the power switch.

19. Prime the pump (see Section B.13). 

Figure 5-8.  Piston Assembly

Avoid all lateral motion when sliding the head onto the piston. Failure
to slide the head straight on will break the piston, as well as damage
the piston seal and back-up seal.

Évitez tout mouvement latéral lorsque vous faites coulisser la tête sur
le piston. Un coulissement non rectiligne de la tête cassera le piston
et en endommagera le joint étanche et le joint étanche de sécurité.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf auf den
Kolben schieben. Andernfalls kann der Kolben abbrechen und die
Kolbendichtung sowie die Hinterspülungsdichtung zerstört werden.
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5.7 Replacing a Pump Piston

Continued leaking from around the pump head after replacing the piston seal 
indicates a scratched or broken piston.

1. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

2. Open the ICS-90 front door.

3. Disconnect the tube fittings from the inlet and outlet check valves (see 
Figure 5-5).

4. While holding the head firmly against the pump housing to compensate for 
the spring loading, remove the two nuts (see Figure 5-7).

5. Slowly release the head and allow it to separate from the housing. 
CAREFULLY disengage the head from the sapphire piston by pulling the 
head straight off and away from the mounting guides (see Figure 5-6). Be 
especially careful not to snap the piston if the spring is stuck to the piston 
guide.

6. Remove the piston guide, spring, spring guide, spring retainer, and piston by 
pulling them straight out, away from the pump housing (see Figure 5-8).

7. If the piston is broken, replace the piston seal and the back-up seal (see 
Section 5.6). This will prevent pieces of broken piston from scratching the 
new piston assembly.

8. Remove the retainer ring (P/N 035010) from the old piston assembly and 
install it on the new piston assembly (P/N 036904).

Lateral motion when disengaging the head from the piston can break
the piston.

Un mouvement latéral pendant la séparation de la tête et du piston
peut casser le piston.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf vom Kolben
lösen. Andernfalls kann der Kolben brechen. 
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9. Carefully slide the spring retainer onto the piston assembly.

10. Slide the assembled piston back into the piston housing.

11. Slide the spring over the piston, positioning it flush against the spring retainer.

12. Carefully slide the pump head straight onto the alignment rods. Guide the 
spring over the piston guide. Gently push the piston through the seal. 

13. Hold the head firmly against the pump housing and replace the two nuts. Use 
a wrench to tighten them evenly.

14. Reconnect the liquid lines to the check valve housings.

15. Reconnect the power cord and turn on the power switch.

16. Prime the pump (see Section B.13).

Avoid all lateral motion when sliding the head onto the piston. Failure
to slide the head straight on will break the piston, as well as damage
the piston seal and back-up seal.

Évitez tout mouvement latéral lorsque vous faites coulisser la tête sur
le piston. Un coulissement non rectiligne de la tête cassera le piston
et en endommagera le joint étanche et le joint étanche de sécurité.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf auf den
Kolben schieben. Andernfalls kann der Kolben abbrechen und die
Kolbendichtung sowie die Hinterspülungsdichtung zerstört werden.
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5.8 Replacing the Waste Valve O-Ring

A damaged O-ring causes leakage around the base of the waste valve knob.

1. Turn off the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

2. Open the front door of the ICS-90.

3. Turn off the gas pressure to the eluent reservoir.

4. Remove the valve from the pump head housing by turning the knob 
counterclockwise until it comes loose from the housing (see Figure 5-9).

5. Remove the O-ring.

6. Carefully slide a new O-ring (P/N 035776) over the end of the valve and push 
it into the groove.

7. Reinstall the valve in the pump head housing, turning the knob clockwise 
until the valve is firmly seated. Do not overtighten the valve knob.

8. Turn on the gas pressure to the eluent reservoir.

9. Close the ICS-90 front door.

10. Prime the pump (see Section B.13).

NOTE If the pump head leaks after replacing the waste valve
O-ring, the valve knob may not have been seated firmly
enough. Tighten the knob further, but only by hand.
Never use a tool.

Figure 5-9.  Pump Head Assembly
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5.9 Rebuilding the Injection Valve

Dionex recommends rebuilding the injection valve annually. The Injection Valve 
Rebuild Kit (P/N 057896) contains all required replacement parts.

NOTE Substitution of non-Dionex parts may impair valve
performance and void the product warranty.

1. Turn off the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

2. Open the front door of the ICS-90.

3. Disconnect each liquid line connected to the injection valve.

4. Follow the instructions provided in the LC25 Injection Valve Maintenance Kit 
(P/N 055676) to replace the rotor seal, isolation seal, and stator face.

5. Reconnect all liquid lines to the injection valve.

6. Close the ICS-90 front door.

7. Turn on the pump from the Control panel.
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5.10 Installing a New DS5 Detection Stabilizer

1. Turn off the power on the ICS-90 rear panel and disconnect the power cord.

2. Open the ICS-90 front door.

3. Disconnect the black ELUENT OUT line from the ELUENT OUT port on the 
suppressor (see Figure 5-10). 

4. Disconnect the orange CELL OUT line from the union that connects it to the 
black CELL OUT line.

5. Use an Allen wrench to remove the two screws on the top of the DS5. 

6. Remove the DS5 by unplugging it from the component mounting panel. 

7. Plug the new DS5 (P/N 057290) into its mounting location.

8. Replace the screws on the top of the DS5 and tighten.

9. Attach the orange CELL OUT line from the DS5 to the union attached to the 
black CELL OUT line. Attach the ELUENT OUT line to the ELUENT OUT port on 
the suppressor.

Figure 5-10.  DS5 Detection Stabilizer Assembly
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10. Close the front door.

11. Reconnect the power cord and turn on the ICS-90 power. 

12. Calibrate the cell (see Section 5.1.2).

5.11 Installing a New Suppressor

Refer to the suppressor manual for guidance about when to replace a suppressor. 
Suppressor manuals are included on the Dionex Reference Library CD-ROM 
(P/N 055405).

1. Turn off the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress.

2. Open the front door of the ICS-90.

3. Disconnect the four eluent and regenerant lines from the suppressor.

4. Slide the suppressor to the left to detach it from the component mounting 
panel.

5. Slide the new suppressor (AMMS III suppressor, P/N 056751; CMMS III 
suppressor, P/N 056753) to the right until it locks into place on the mounting 
panel.

6. Connect the four eluent and regenerant lines to the new suppressor.

7. Close the ICS-90 front door.

8. Prime the pump (see Section B.13).
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5.12 Changing the Main Power Fuses

1. Turn off the main power and disconnect the power cord.

2. The fuse holder is part of the main power receptacle on the ICS-90 rear panel. 
Note the recessed lock located on each side of the fuse holder (see 
Figure 5-11). 

Using a small screwdriver, push each lock toward the center to release it. 
When both locks are released and the fuse holder pops out slightly, pull the 
fuse holder straight out of its compartment.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the ICS-90.

HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arrière du ICS-90.

HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Rückseite des ICS-90.

Figure 5-11.  Main Power Fuse Holder
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3. Replace the two fuses in the holder with new IEC 127 fast-blow fuses rated 
3.15 amps (P/N 054745). Dionex recommends always replacing both fuses.

4. Reinsert the fuse holder into its compartment. The fuse holder is keyed to fit 
only in its proper orientation. Apply sufficient pressure evenly against the 
holder to engage the two locks. The holder is flush against the panel when 
both locks are engaged. 

5. Reconnect the main power cord and turn on the power.
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A • Specifications

A.1 Electrical

A.2 Physical

Main Power Two voltage/frequency configurations (not user-selectable):
110–120 VAC/60 Hz
220–240 VAC/50 Hz
100 VAC/50 Hz

 Fuses Two fast-blow IEC 127 fuses rated 3.15 A (P/N 954745) 

Dimensions
(with reservoirs

and tubing)

Height without reservoirs: 32.125 cm (12.85 in)
Height with reservoirs and cap tubing: 59.63 cm (23.85 in)
Width: 23.23 cm (9.29 in)
Depth: 39.73 cm (15.89 in)

Weight 14 kg (30 lb)

Decibel Level < 53 dBA
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A.3 Environmental

A.4 Front Panel

 Operating
Temperature

10 to 35 °C (50 to 95 °F)

Humidity 5% to 95% relative humidity, noncondensing

 Gas Pressure Laboratory-quality clean gas regulated to between 0.55 and 
0.83 MPa (80 and 120 psi)

Operating
Pressure

28 MPa (4000 psi) maximum liquid path (tubing, valve, columns, 
etc.)

Operational
LED Indicators

LEDs display the ICS-90 operational status: 

• Power
Off: No power
On: Power present

• Ready
Off: Not connected to Chromeleon or Chromeleon Xpress
On: System check passed and the ICS-90 is connected to 
Chromeleon or Chromeleon Xpress
Flashing: System check failed (occurs if system check 
executes for 10 minutes without success)

• Run
Off: Not running
On: Running/acquiring data
Flashing: Error/alarm/fault (including injection valve position 
fault)
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A.5 Rear Panel

A.6 Pump

A.7 Pulse Damper

Link LED The Link LED displays the communication status between the 
ICS-90 and Chromeleon or Chromeleon Xpress:
Off: There is no communication link between the ICS-90 and 
Chromeleon or Chromeleon Xpress.
On: The communication link between the ICS-90 and Chromeleon 
or Chromeleon Xpress is activated, but data is not being transmitted 
or received.
Flashing: The communication link between the ICS-90 and 
Chromeleon or Chromeleon Xpress is activated and data is being 
transmitted or received.

Type High performance pump with metal-free flow path and PEEK 
components

Operation Mode Constant volume

Flow Rate 0.5 to 4.5 mL/min

Operating
Pressure

28 MPa (4000 psi) maximum 

Type 0.75-mm (0.030-in) ID tubing

Maximum
Pressure

28 MPa (4000 psi)
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A.8 Detector

A.9 DS5 Detection Stabilizer

A.10 Injection Valve

A.11 Delay Volume

Range Digital signal range of 0 to 500 μS or 0 to 10,000 μS (user-
selectable)

Temperature
Compensation

Preset for accurate reading at 40 ºC

Cell Drive 8 kH square wave

Auto Offset -999 to 999 μS

Control and
Data Evaluation

Provided by Chromeleon or Chromeleon Xpress software; 
communication with the ICS-90 is via USB (Universal Serial Bus)

Linearity 1%

Cell Body PEEK

Electrodes Passivated 316 stainless steel

Active Volume 1 μL

Maximum
Pressure

2.0 MPa (300 psi)

Injection Valve Two-position, six-port, electrically-activated Rheodyne valve with 
PEEK wetted components

System Total <5 mL
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B • Installation

This chapter provides instructions for the initial installation of the ICS-90 Ion 
Chromatography System (ICS-90). 

NOTE A printed installation manual (Document No. 031856) is
shipped with the ICS-90.

B.1 Facility Requirements

• Make sure the ICS-90 installation site meets the power and environmental 
specifications listed in Appendix A.

• The ICS-90 requires a sturdy workbench of a height that ensures convenient 
access to the interior.

• Allow at least 15 cm (6 in) behind the ICS-90 for power connections and 
ventilation. For optimal performance, install the ICS-90 in a draft-free 
location, out of the path of air conditioning and heating vents.

• A clean gas source regulated to between 0.55 and 0.83 MPa (80 and 120 psi) 
is required for pressurization of the eluent reservoir.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.
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B.2 Unpacking the ICS-90 System

B.2.1 Unpacking the ICS-90

1. Open the shipping box.

2. Remove the eluent reservoir assembly and the ICS-90 Ship Kit 
(P/N 059947).

3. Remove the foam cover.

4. Using the cardboard side handles, carefully remove the ICS-90 from 
the box. You may need to remove the foam at the sides of the ICS-90 
before you can lift the instrument from the box.

5. Set the ICS-90 on a workbench and cut the tape to remove the plastic 
surrounding the instrument.

6. Inspect the ICS-90 for any shipping damage.

Lift the ICS-90 only from each side of the cabinet bottom. Lifting from
the front door will damage the door hinges. Use caution when lifting
the module: it weighs 19 kg (42 lb).

Ne soulevez le ICS-90 que par le fond ou les côtés. Son soulèvement
par la porte du panneau avant endommagera les charnières de la
porte. Soyez prudent lorsque vous soulevez le ICS-90: il pèse 19 kg
(42  lb).

Heben Sie das ICS-90 nur an, indem Sie von beiden Seiten unter den
Boden greifen. Wenn Sie das Gerät an der Vordertür anheben,
beschädigen Sie die Türangeln. Vorsicht beim Heben des Moduls: Es
wiegt 19 kg.



B • Installation

Doc. 031851-08 12/06 81

B.2.2 Removing the Pump Shipping Screw

1. Carefully lay the ICS-90 on its back or side.

2. Locate the middle screw on the bottom of the ICS-90 (see 
Figure B-1). This screw secures the pump in place during shipment.

3. Use a Phillips screwdriver to remove the shipping screw. 

4. A screw holder is located to the right of the screw (see Figure B-1). 
Place the screw in the holder for safekeeping. You will need to 
reinstall the screw if the ICS-90 is shipped to another location.

5. Return the ICS-90 to an upright position.

Figure B-1.  Pump Shipping Screw Removal

Shipping Screw
Screw Holder

Bottom View of ICS-90

Front

Rear
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B.2.3 Unpacking the Computer

Outside North America

1. Remove the computer and all documentation from the computer box 
and place them on a workbench.

2. Chromeleon and Chromeleon Xpress run under the Microsoft 
Windows XP and Windows 2000 operating systems. Refer to 
http://www.dionex.com to verify that the PC meets current system 
specifications.

3. Follow the instructions in the computer installation guide to hook up 
the PC components. 

4. When you finish, go to Section B.3 to install the chromatography 
software.

North America Only

NOTE These instructions assume that Chromeleon or
Chromeleon Xpress and the software license were
installed on the PC before shipment from Dionex.

1. Remove the computer and all documentation from the computer box 
and place them on a workbench.

2. Follow the instructions in the computer installation guide to hook up 
the PC components.

3. When you finish, go to Section B.4 to connect the PC to the ICS-90.

http://www.dionex.com
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B.3 Installing the Chromatography Software

B.3.1 Installing the Software

NOTE Dionex strongly recommends installing Chromeleon
or Chromeleon Xpress before connecting the ICS-90
to the computer. When the chromatography
software is installed first, USB driver information is
loaded automatically and the Windows operating
system will detect the ICS-90 when the power is
turned on.

The SETUP.EXE file on the Chromeleon CD-ROM installs the software. 
After presenting a series of options for your consideration, the Setup 
program then copies the software onto the hard disk.

1. If this is a local computer, log onto Windows XP or Windows 2000 as 
an administrator. If this is a network computer, log on as a user with 
local computer administrator privileges.

If necessary, ask the computer systems administrator for temporary 
administrator privileges. (Administrator privileges are required to 
install Chromeleon or Chromeleon Xpress, but not to operate it.)

2. Verify that the drive on which you plan to install the Chromeleon or 
Chromeleon Xpress application has at least 250 MB of free disk 
space. This is the amount of free disk space required for operation.

Chromeleon only: 250 MB may not be enough disk space to store 
the large amounts of data that Chromeleon can generate. If necessary, 
you can store data at a different location (for example, on a network).

3. Insert the Chromeleon CD-ROM into the PC drive. The Chromeleon 
Setup menu should appear. 

If the Setup menu does not appear automatically, go to the Autorun 
folder on the Chromeleon CD-ROM and double-click autorun.exe. 
(The .exe extension is not always visible; it depends on the computer 
settings.)

4. Select Launch Chromeleon Setup.

5. Setup now guides you through the installation procedure; follow the 
instructions on the screen. 
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6. When prompted whether to add the Server Monitor program to the 
Startup group, select Yes if the computer will be physically connected 
to devices or No if the computer will never be connected to devices.

When Yes is selected, the Server Monitor automatically starts when 
the computer is started and the program icon is displayed on the 
taskbar. 

7. After installing the software, restart the computer.

8. Microsoft Windows should automatically detect the ICS-90 and 
launch the Found New Hardware Wizard. (If this does not happen, 
refer to the Troubleshooting Tip below.) Complete the wizard by 
selecting the following options:

a. If asked whether Windows can connect to Windows Update to 
search for software, select No, not this time.

b. Accept the default option (Install the software automatically) 
and click Next >.

c. When the wizard reports that the software for the module has 
been installed, click Finish.

Troubleshooting Tip

If a Microsoft Windows message box asks for the USB configuration file 
(cmwdmusb.inf), it indicates that you connected the ICS-90 to the PC and 
turned on the ICS-90 power before installing Chromeleon or Chromeleon 
Xpress.

Follow these steps to resolve the problem:

1. Click Cancel in the Windows message box.

2. Turn off the power to the ICS-90 and unplug the USB cable from the 
computer.

3. Install Chromeleon or Chromeleon Xpress.

4. Reconnect the USB cable to the computer and turn on the power to 
the ICS-90. Windows will now automatically recognize the ICS-90.
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B.3.2 Installing the Software License

In order for the Chromeleon or Chromeleon Xpress computer to control 
the ICS-90, a valid software license must be installed. To install the 
license, you must first install a dongle on the computer and then enter a 
license Key Code in Chromeleon. (A dongle is an adapter that is 
connected to the parallel PC interface or USB port. The dongle stores the 
serial number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required. 

1. Plug the dongle into the appropriate port on the computer (either a 
parallel or USB port, depending on the type of dongle). For a parallel 
port dongle, be sure to tighten the connector screws.

2. If it is not already running, start the Chromeleon Server Monitor 
(select Start > Chromeleon > Server Monitor). 

The Server Monitor window opens.

• If Chromeleon or Chromeleon Xpress was installed on the 
computer before shipping, the Server Monitor status will display 
“Chromeleon Server is running idle.” (This is because the license 
Key Code was entered before shipping.) If this is the case, click 
Close and go on to “Creating a Timebase” (see Section B.7.1).

• If Chromeleon or Chromeleon Xpress was not pre-installed, the 
Server Monitor status displays “Chromeleon Server is running 
idle (Evaluation Mode).” (see Figure B-2). If this is the case, go 
on to Step 3.

Figure B-2.  Server Evaluation Mode
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3. Open the Chromeleon Server Configuration program (select Start > 
Chromeleon > Server Configuration).

4. Select Edit > Properties to open the Server Configuration properties 
dialog box (see Figure B-3). Click Dongle and then enter the Key 
Code provided with the Chromeleon license. Click OK.

Figure B-3.  Server Configuration Properties

5. Check the Server Monitor status. It should now display “Chromeleon 
Server is running idle.” (see Figure B-4).

Figure B-4.  Server Running

6. Click Close to close the Server Monitor window.
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B.3.3 Starting the Chromeleon Server Monitor

1. If the Chromeleon Server Monitor program did not start 
automatically, start it now by double-clicking the Server Monitor icon 
on the Windows taskbar. 

If the Server Monitor icon is not on the taskbar, click Start on the 
taskbar and select All Programs (or Programs, depending on the 
operating system) > Chromeleon > Server Monitor. 

2. If the server is not already running, start it by clicking Start. 

3. Click Close to close the Server Monitor program window.

The Server Monitor icon appears on the taskbar.

NOTE Clicking the Quit Monitor button quits (or
exits) the Server Monitor program, but does not
stop the server. To stop the server, click the Stop
button.
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B.4 Connecting the ICS-90 to the Computer

The ICS-90 rear panel (see Figure B-5) provides one USB receptacle. Select one 
of the following methods for connecting the ICS-90 to the PC on which 
Chromeleon or Chromeleon Xpress is installed:

• Connect the ICS-90 directly to a USB port on the PC.

• If there are no unused USB ports on the PC, connect the ICS-90 to an external 
USB hub (P/N 060392) and connect the PC to the hub.

If the dongle provided with Chromeleon or Chromeleon Xpress is for a USB port, 
remember to reserve a USB port for the dongle on either the PC or the hub.

Before connecting the USB cable and turning on the ICS-90 power,
verify that Chromeleon or Chromeleon Xpress is installed on the PC
(see Section B.3.1).

Figure B-5.  ICS-90 Rear Panel
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To connect the ICS-90 directly to the PC:

1. Locate the USB cable (P/N 960777) provided in the ICS-90 Ship Kit 
(P/N 059947). 

2. Plug the “A” connector of the USB cable into the USB port on the PC 
(see Figure B-6).

3. Plug the “B” connector of the USB cable into the USB receptacle on 
the ICS-90 rear panel (see Figure B-6).

To connect the ICS-90 to an external hub (P/N 060392):

The ICS-90 Ship Kit (P/N 059947) includes one USB cable 
(P/N 960777). You must order another USB cable for this configuration.

 

1. Plug the “A” connector of a USB cable into a port on the external 
USB hub (see Figure B-7).

2. Plug the “B” connector of the cable into the USB receptacle on the 
ICS-90 rear panel (see Figure B-7).

Figure B-6.  Example Connections: One ICS-90 Connected to the Computer

The USB standard limits the USB cable length to 5 m (5.5 yds). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 m (32 yds)
from the PC.

Carefully secure all USB cables, the external hub, and the hub power
cable so that they cannot be accidentally disconnected.
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3. Plug the “A” connector of a USB cable into a USB port on the 
computer (see Figure B-7). 

4. Plug the “B” connector of the cable into a port on the USB hub.

B.5 Connecting the Power Cord

1. A label on the ICS-90 rear panel indicates the line frequency (60 Hz or 50 Hz) 
and voltage (110 to 120 VAC or 220 to 240 VAC) for which the system is 
designed. Make sure the frequency and voltage are appropriate for your 
location. If you are unsure, consult an electrician.

2. Connect the power cord (IEC 320 C13) from the main power receptacle on 
the rear panel (see Figure B-5) to a grounded power source.

Figure B-7.  Example Connections: Multiple Modules Connected to an External Hub

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-90 or connect it to AC power mains
without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-90 and is easily
accessible.
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Plug the USB cable’s “A” connector 
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B.6 Turning On the ICS-90 Power

1. Turn on the computer power. If this is a local computer, log onto Windows XP 
or Windows 2000 as an administrator. If this is a network computer, log on 
as a user with local computer administrator privileges.

2. Turn on the power to the ICS-90. The operating system automatically detects 
the new USB device. A message flashes on the screen to inform you that the 
device was detected.

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-90.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.

Before turning on the ICS-90 power, verify that Chromeleon or
Chromeleon Xpress is installed. If the chromatography software is not
installed first, the Windows operating system will be unable to identify
the new USB device.
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B.7 Setting Up the Chromatography Software

B.7.1 Creating a Timebase

1. In the Server Configuration program, select Edit > Add Timebase.

2. A clock icon appears under the server name with a default name 
highlighted. To use the default name, press Enter. To use a different 
name, type the name and press Enter. Figure B-8 shows an example 
timebase named ICS-90.

Figure B-8.  Example: Creating a Timebase

3. Select Edit > Add Device. The Add device to timebase dialog box 
appears.

Figure B-9.  Add Device to Timebase Dialog Box
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4. Select ICS-90 IC System from the list and click OK. A dialog box 
appears.

Figure B-10.  ICS-90 Configuration Properties: Live Mode

5. On the General tab page, Live Mode is selected by default. Select 
the ICS-90 serial number from the drop-down list. If you are 
installing more than one ICS-90, you can verify the serial number for 
each system by checking the label at the top of the component panel 
(see Figure B-17).
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6. Click Options to display the Options tab page.

7. Select the conductivity range (0 to 500 μS or 0 to 10,000 μS) from the 
drop-down list under Set Detection Limits. Selecting the larger 
(coarse) range reduces the detector’s resolution by a factor of 20.

8. Click OK to close the properties dialog box. 

9. Save the configuration (select File > Save Installation). 

10. The Server Configuration Check message window appears. You can 
ignore the “no inject device installed” warning, if it appears. This 
simply means that the timebase does not include an autosampler. 
Click Close.

11. Exit the Server Configuration program.
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B.7.2 Connecting to the Control Panel

1. Click Start on the Windows taskbar and select All Programs (or 
Programs) > Chromeleon > Chromeleon to start the Chromeleon 
client.

2. If Chromeleon is installed, select View > Default Panel Tabset or 

click  on the toolbar to display the panel tabset.

NOTE If Chromeleon Xpress is installed, starting the
client automatically displays the panel tabset.

3. To display the ICS-90 (or ICS-90A) Control panel (see Figure B-11), 
select the ICS-90 tab on the panel tabset. (The ICS-90A Control 
panel includes a Wellness Panel button; otherwise, the panels are 
identical.)

Figure B-11.  ICS-90 Control Panel on the Panel Tabset
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4. If a “Cannot connect to timebase…” message appears, click OK to 
close it.

NOTE If the timebase was named “ICS-90” when it
was created, the Control panel opens and
connects automatically to the ICS-90 timebase.

5. If the Control panel opens with the controls not yet active, connect the 
system to the Control panel by clicking the Connect button.

A dialog box appears (see Figure B-12). 

Figure B-12.  Connect to Timebase

6. Click the plus sign beside My Computer on the right side of the 
dialog box and select the timebase you created in Section B.7.1. Click 
OK to close the dialog box.

The controls on the panel are now connected.
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B.7.3 Verifying Communication with the ICS-90

To verify that Chromeleon or Chromeleon Xpress is communicating with 
the ICS-90, click the Disconnect and then the Connect button on the 
Control panel while observing the ICS-90 front panel LEDs. 

If the ICS-90 and the chromatography software are communicating 
correctly, the Power and Ready LEDs are on when the ICS-90 is 
connected to Chromeleon or Chromeleon Xpress, and only the Power 
LED is on when it is disconnected.

Figure B-13.  ICS-90 LEDs Connected and Disconnected States
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B.8 Connecting the Waste Lines

Untape the coiled waste and liquid lines from the rear panel. Place the ends of the 
three waste lines into a waste container. The waste lines siphon off prime waste 
from the pump head, sample overflow from the injection valve, and system waste 
from the suppressor. 

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

A DCR waste backpressure tubing assembly (P/N 060214) is installed
on the free end of the MMS III waste line (see Figure B-14). The
assembly consists of a coupler and a 6-inch length of 0.25-mm
(0.010-in) ID black tubing. 

The tubing assembly provides a small amount of backpressure to
compress any air bubbles formed in the suppressor’s regenerant
chamber. If you shorten or replace the MMS III waste line, remember to
reinstall the backpressure tubing assembly. Failure to do so will result
in high baseline drift.

Figure B-14.  DCR Waste Backpressure Tubing Assembly
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B.9 Connecting the Gas Source

1. Locate the barbed fitting (P/N 030071), pipe thread reducer (P/N 030087), 
1/8-in ID tubing (P/N 040793), and ICS-90 air regulator accessory 
(P/N 060054) in the ICS-90 Ship Kit (P/N 059947).

2. Use the barbed fitting and pipe thread reducer to connect the 1/8-in ID tubing 
to a clean gas source regulated to between 0.55 and 0.83 MPa (80 and 
120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see 
Figure B-15).

NOTE Do not turn on the gas source. Do not pressurize until
the eluent is prepared and the ICS-90 is plumbed.

Figure B-15.  ICS-90 Air Regulator Accessory
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B.10 Setting Up the Eluent and Regenerant Reservoirs

1. Rinse the eluent and regenerant reservoirs.

2. Prepare 2 L of eluent. For instructions, see the manual for the column being 
installed. Column manuals are included on the Dionex Reference Library CD-
ROM (P/N 055405).

3. Follow the instructions below to prepare either anion (dilute sulfuric acid) or 
cation (tetrabutylammonium hydroxide (TBAOH)) regenerant.

a. Fill the regenerant reservoir (anion, P/N 057712; cation, P/N 057713) 
about halfway with ASTM filtered, Type I (18-megohm) deionized (DI) 
water. 

b. Empty the entire bottle of concentrate into the reservoir.

c. Fill the concentrate bottle with DI water and empty the contents into the 
reservoir.

d. Continue to pour DI water into the reservoir until it is filled all the way to 
the top. If a few drops spill over, then it is full enough.

e. Insert the stopper assembly tubing into the reservoir and tighten the 
stopper. 

For acid concentrates (such as the anion regenerant), always pour the
concentrate into deionized water, not into the empty reservoir.

Pour les concentrés acides (comme le régénérant anionique), versez
toujours le concentré dans de l'eau désionisée et non dans le
réservoir vide.

Gießen Sie bei säurehaltigen Konzentraten (beispielsweise dem
Kationenelutionsmittel) das Konzentrat immer in entionisiertes
Wasser und nicht in den leeren Behälter.

The regenerant reservoir must be filled all the way to the top at all
times.

Do not shake the regenerant reservoir to mix the contents. The ICS-90
will stratify the contents.
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For additional information, refer to the Installation Instructions and 
Troubleshooting Guide for the Displacement Chemical Regeneration (DCR) 
Kit (Document No. 031664). The manual is included on the Dionex Reference 
Library CD-ROM (P/N 055405).

4. Make sure the regenerant reservoir is filled almost to overflowing. 

5. Slip the air regulator accessory bracket over the neck of the eluent reservoir.

6. Install the caps on the eluent and regenerant reservoirs and hand tighten.

7. Place the reservoirs in the holders on the top cover of the ICS-90.

8. Connect the liquid lines from the ICS-90 to the lines exiting the eluent and 
regenerant reservoir caps (see Figure B-16) as follows:

• Connect the two lines labeled Eluent Bottle Out. 

• Connect the two lines labeled Regen Bottle Out.

• Connect the line labeled Regen In to the green Regen Bottle In line from 
the ICS-90.

Figure B-16.  Reservoir Connections
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9. To ensure the correct operating pressure for the suppressor, at least one 
backpressure coil (P/N 045877) must be installed between the cell outlet and 
the regenerant reservoir inlet. The application flow rate determines the 
number of coils required:

a. For flow rates less than 2 mL/min, verify that two coils are installed.

b. For flow rates of 2 mL/min or more, remove one of the backpressure 
coils.

NOTE Refer to the flier entitled Backpressure Coil Pressure
Test for Dionex Suppressors (Document No. 031759)
(shipped with the suppressor) for details about
suppressor operating pressure requirements.

10. Connect the orange gas line from the eluent reservoir to the gas line on the air 
regulator outlet.

B.11 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. For
detailed installation information, refer to the column
and suppressor manuals provided on the Dionex
Reference Library CD-ROM (P/N 055405).

1. Remove the guard column, separator column, and MMS III suppressor from 
their boxes. Remove the fitting plugs from the ends of each column and from 
all ports on the suppressor. Discard the tubing that temporarily connected the 
suppressor ports.

2. Plumb the guard and separator columns. Refer to the labels on the tubing, to 
Figure B-17, and to the following instructions.

Application Flow Rate Number of Required
Backpressure Coils

Less than 2 mL/min 2
2 mL/min or more 1
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a. Remove the union connecting GUARD IN and GUARD OUT and connect 
GUARD IN to the guard column inlet. Check the arrow on the column 
label; it should point away from the injection valve.

b. Connect GUARD OUT to the guard column outlet.

c. Push the guard column onto the clips.

d. Remove the union connecting COL IN and COL OUT and connect COL IN to 
the separator column inlet. Connect COL OUT to the separator column 
outlet. Check the arrow on the column label. It should point toward the 
cell (DS5).

e. Push the column onto the clips.

Figure B-17.  ICS-90 Component Panel (Door not shown)
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3. Plumb the MMS III suppressor as follows:

a. Install the suppressor onto the brackets located below the DS5 (see 
Figures B-17 and B-18).

b. Remove the union connecting ELUENT IN and ELUENT OUT and connect 
ELUENT IN and ELUENT OUT to the corresponding ports on the suppressor.

c. Remove the union connecting REGEN IN and REGEN OUT and connect 
REGEN IN and REGEN OUT to the corresponding ports on the suppressor.

4. To ensure the correct operating pressure for the suppressor, at least one 
backpressure coil (P/N 045877) must be installed between the cell outlet and 
the regenerant reservoir inlet. The application flow rate determines the 
number of coils required:

Figure B-18.  ICS-90 with Columns and Suppressor Installed

Application Flow Rate Number of Required
Backpressure Coils

Less than 2 mL/min 2
2 mL/min or more 1
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a. For flow rates less than 2 mL/min, verify that two coils are installed.

b. For flow rates of 2 mL/min or more, remove one of the backpressure 
coils.

NOTE Refer to the flier entitled Backpressure Coil Pressure Test
for Dionex Suppressors (Document No. 031759) (shipped
with the suppressor) for details about suppressor
operating pressure requirements.

B.12 Pressurizing the Eluent Reservoir

NOTE Do not pressurize the regenerant reservoir.

1. Pull out the air regulator knob and turn it fully counterclockwise to ensure 
there is no pressure to the reservoir when the gas source is turned on. 

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the eluent 
reservoir. 

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the regulator 
knob back in. 

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus. 
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B.13 Priming the Pump

1. Verify that the eluent and regenerant reservoirs are filled, the reservoir caps 
are installed and hand-tightened, and the gas and liquid lines are connected to 
the reservoirs (see Section B.10).

2. Verify that the gas supply is turned on, the eluent reservoir is pressurized (see 
Section B.12), and the regenerant reservoir is unpressurized. Note: The 
regenerant reservoir is unpressurized if the reservoirs are connected as 
described in Section B.10. 

3. Verify that the waste lines are directed to a waste container.

4. To start the liquid flow, open the pump head waste valve (see Figure B-19) by 
turning the knob counterclockwise two turns. When the valve is open, eluent 
flows directly from the pump to waste.

5. Let the liquid flow for at least 2 to 3 minutes to ensure that there are no 
trapped gas bubbles in the line from the eluent reservoir to the pump head. 

Figure B-19.  ICS-90 Interior Components
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6. Turn on the pump from the ICS-90 (or ICS-90A) Control panel in 
Chromeleon or Chromeleon Xpress. Allow the pump to run with the waste 
valve open for 30 seconds.

7. Close the waste valve knob.

B.14 Setting the Pump Flow Rate (ICS-90 only)

The instructions in this section apply to the ICS-90 only. If you are unsure 
whether your system is an ICS-90 or ICS-90A, check the model data label on the 
rear panel.

B.14.1 Setting the Flow Rate

1. Locate the production test chromatogram on the Dionex Quality 
Assurance Report (supplied with the separator column). Note the 
backpressure and flow rate listed for the column.

2. Pull out the flow rate knob on the component mounting panel (see 
Figure B-19) and turn the knob to the right to begin adjusting the 
pressure. 
NOTES

• There is about a 10-second delay between adjusting the knob and 
the pressure reading response on the ICS-90 Control panel in 
Chromeleon or Chromeleon Xpress.

• The flow rate on the ICS-90 Control panel is a recorded value only 
and does not change when the flow rate knob is adjusted.

3. Adjust the knob until the pump pressure reading on the ICS-90 
Control panel reaches the figure listed on the production test 
chromatogram.

NOTE The production test chromatogram is produced
without a guard column. If a guard column is
installed, adjust the knob until the pressure is
about 1.4 to 2.1 MPa (200 to 300 psi) above the
backpressure listed for the separator column
alone. 
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4. Measure the flow rate, using one of the following methods: 

• Volumetrically (recommended for most applications): Measure 
the volume of liquid collected over a measured time period (see 
page 108 or page 109).

• Gravimetrically: Weigh the mass of liquid collected over a 
measured time period (see page 109). The gravimetric method is 
slightly more accurate than the volumetric method.

Volumetric Method 1 (Recommended): Using a Syringe and Adapter

a. Locate the following items in the ICS-90 Ship Kit (P/N 059947): luer 
fitting (P/N 024305), luer coupler (P/N 042806), 1 mL syringe 
(P/N 016388), and 10 mL syringe (P/N 016387). You will also need a 
stopwatch or a clock or watch with a second hand (the computer’s clock 
can be used), and a small beaker or other container for collecting waste.

b. Connect the luer coupler to the luer fitting. 

c. Select the syringe to be used: 

• For a flow rate of 0.5 mL/min, use the 1 mL syringe.

• For a flow rate above 0.5 mL/min, use the 10 mL syringe.

d. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. Connect the luer coupler to the ELUENT IN line, and connect 
the syringe to the luer fitting (see Figure B-20).

Figure B-20.  Assembled Syringe and Luer Adapter
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e. Using a stopwatch or clock’s second hand, time the flow of eluent into the 
syringe for 60 seconds. Determine the volume collected by noting the 
beginning and ending positions of the syringe plunger. 

f. The volume of eluent collected in 60 seconds should be approximately 
equal to the desired flow rate in milliliters per minute. For example, for a 
flow rate of 1 mL/min, the volume should be 1.0 ± 0.1 mL.

g. If necessary, adjust the flow rate knob, and then repeat the measurement. 
Continue adjusting until the desired milliliters per minute is collected.

h. Reconnect the ELUENT IN line to the suppressor.

Volumetric Method 2: Using a Graduated Cylinder

a. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

b. Using a clock or watch with a second hand (the computer’s clock can be 
used), collect eluent from the ELUENT IN line into a small graduated 
cylinder for 2 minutes.

c. The collected eluent should be approximately equal to the desired flow 
rate in milliliters per minute. For example, for a flow rate of 1 mL/min, 
2.0 ± 0.2 mL should be collected in 2 minutes.

d. If necessary, adjust the flow rate knob, and then repeat the measurement. 
Continue adjustments until the desired eluent per minute is collected.

e. Reconnect the ELUENT IN line to the suppressor.

Gravimetric Method

a. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

b. Using a tared beaker and a calibrated stopwatch, collect the eluent from 
the ELUENT IN line for 60 seconds.

c. Weigh the mass of the eluent. The mass (in grams) should be 
approximately equal to the desired flow rate in milliliters per minute. For 
example, for a flow rate of 0.5 mL/min, the mass of the collected eluent 
should be 0.5 ± 0.02 g.

d. If necessary, adjust the flow rate knob, and then repeat Step b and Step c. 
Continue adjusting until the desired mass per minute is collected.

e. Reconnect the ELUENT IN line to the suppressor.
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B.14.2 Recording the Measured Flow Rate

1. From the ICS-90 Control panel, press the F8 key or select Control > 
Command.

2. Click the plus sign next to Pump_ECD to display the items 
underneath. Select MeasuredFlowRate (see Figure B-21).

3. Enter the flow rate in the space provided and click Execute. 

4. Click Close. The measured flow rate is now shown on the Control 
panel.

Figure B-21.  ICS-90 Chromeleon Commands: MeasuredFlowRate
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B.15 Setting the Pump Flow Rate (ICS-90A only)

NOTE The instructions in this section apply to the ICS-90A
only. If you are unsure whether your system is an ICS-90
or ICS-90A, check the model data label on the rear
panel.

The ICS-90A has a feature that allows the approximate flow rate to be displayed 
on the Control panel in Chromeleon or Chromeleon Xpress. The accuracy of the 
displayed flow rate depends on the flow rate at which the system was calibrated 
and the current pump pressure.

The ICS-90A flow rate is calibrated at the factory before shipment and does not 
need to be calibrated now. However, if you will typically operate the ICS-90A at a 
particular flow rate, you may wish to calibrate the system at that flow rate to 
improve flow rate accuracy. For calibration instructions, refer to Section 5.1.3.

To set the pump flow rate:
Pull out the flow rate knob on the component mounting panel (see Figure B-19) 
and turn the knob until the desired flow rate is displayed on the ICS-90A Control 
panel.

B.16 Equilibrating the System

1. After priming the pump and adjusting the flow rate, leave the pump on and 
flush the system for about 5 minutes to equilibrate.

2. Monitor the system pressure from the ICS-90 Control panel to make sure the 
pressure is between 107 and 153 MPa (1600 and 2300 psi). If the pressure is 
less than 107 MPa (1600 psi), gas may be trapped in the system. Release the 
gas by opening one fitting at a time from the pump head and along the 
plumbing to the column; pay close attention to the line from the pulse damper 
(see Figure B-19).

3. Check that there are no leaks in the regenerant reservoir.

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 μS for a system 
set up for anion analyses, and <2 μS for a system set up for cation analyses.
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B.17 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure. Record the short-term pressure fluctuations; they 
should be less than 0.13 MPa (20 psi).

B.18 Connecting the AS40 Automated Sampler (Optional)

1. Open the front door of the ICS-90 and thread the outlet line from the AS40 
through the side slot near the lower ICS-90 door hinge (see Figure B-18).

2. Connect the outlet line from the AS40 to port S (5) of the injection valve (see 
Figure B-22). 

3. Follow the steps below to connect the TTL Output connector on the ICS-90 
rear panel to the RELAY CONTROL connector on the AS40 rear panel.

a. Locate the Relay Control cable (P/N 047946) supplied with the AS40. 

b. Connect the Relay Control cable's 10-pin connector to the RELAY 
CONTROL connector on the AS40 rear panel (see Figure B-23).

Figure B-22.  Injection Valve Connections
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c. Plug the 2-pin connector from the pair of wires labeled LOAD on the 
Relay Control cable into the TTL Output connector on the ICS-90.

B.19 Operating the ICS-90

ICS-90 installation is complete. For routine operation, refer to Section 3.5.

B.20 Installation Troubleshooting

Problem: When the ICS-90 power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon or Chromeleon Xpress was installed.

Solution: 

1. Click the Cancel button in the Windows message box. 

2. Turn off the ICS-90 power and unplug the USB cable from the computer.

3. Install Chromeleon or Chromeleon Xpress (see Section B.3.2).

4. Reconnect the USB cable to the computer and turn on the ICS-90 power. 
Windows will now automatically recognize the new ICS-90. 

Figure B-23.  AS40 Automated Sampler Connection
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C • Reordering Information

Part Number Item

Pump
057853 Pump head assembly
055870 Main piston seal
036901 Backup piston seal
035776 O-ring
047661 Outlet check valve assembly, 10-32
047660 Inlet check valve assembly, 1/4-28
057233 Backup washer assembly
035030 Piston guide
036904 Piston
035014 Piston return spring
035595 Piston spring guide
035885 Washer (installed under acorn nut on pump head assembly)
036884 Acorn nut (secures the pump head to the pump housing)

Sample Loop and Injection Valve
042949 10 μL sample loop assembly

057896 Injection valve rebuild kit

024305 Luer adapter fitting, 1/4-28 (for manual injections)

Reagent Reservoir Assemblies
057711 Eluent reservoir assembly (includes stopper and cap)
057712 Anion regenerant reservoir assembly (includes stopper and cap)
057713 Cation regenerant reservoir assembly (includes stopper and cap)
059068 O-ring for eluent or regenerant reservoir stopper
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Reagents
057559 Anion Regenerant Concentrate (75 mL of 2.0 N sulfuric acid)
057555 4-Pack of Anion Regenerant Concentrate
057561 Cation Regenerant Concentrate (100 mL of 2.06 M TBAOH)
057556 4-Pack of Cation Regenerant Concentrate

Suppressors and Cell
056751 AMMS III suppressor
056753 CMMS III suppressor
057290T DS5 Detection Stabilizer

Part Number Item
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D • FAQ

D.1 How do I hook up an AS40 Automated Sampler?

For instructions on how to connect the ICS-90 to an AS40, see Section B.18 of 
this manual. Also see the AS40 Automated Sampler Operator’s Manual 
(Document No. 034970). The manual is included on the Dionex Reference 
Library CD-ROM (P/N 055405).

D.2 How do I print?

Click the Print toolbar button in Chromeleon or Chromeleon Xpress.

D.3 How often should I perform calibrations?

Recalibrate every six months or after changing a major component (separator 
column, DS5, suppressor, etc.).

D.4 Why are the retention times moving?

Retention times can shift if the pump flow is erratic or if the column or eluent is 
contaminated. See Section 4.6 for pump flow rate troubleshooting. If a 
contaminated column is suspected, clean the column as instructed in the column 
manual. Column manuals are included on the Dionex Reference Library CD-
ROM (P/N 055405).

D.5 How do I adjust retention times?

Retention times are calculated during calibration. The Use Recently Detected 
Retention Time parameter in the Chromeleon QNT Editor (General tab) can be 
used to compensate for some types of retention time drifts; for example, 
evaporation of volatile components in pre-mixed solvents or an aging column. 
Refer to the Chromeleon Help or user’s guide for details.
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D.6 When should I remake standards?

Standards are used only for calibration and should always be made fresh (they 
have a lifetime of only one week).

D.7 When should I remake eluents?

Eluents should be remade every two or three weeks.

D.8 How do I start Chromeleon or Chromeleon Xpress?

Click Start on the Windows taskbar, and then select Programs > Chromeleon > 
Chromeleon.

D.9 How do I back up data?

In Chromeleon, select File > Export/Backup. Back up the data and indicate the 
backup source. Chromeleon Xpress does not allow data to be saved.

D.10 How do I delete data?

In the Chromeleon Browser, highlight the sequence you want to delete and then 
select File > Delete.

D.11 How do I shut off the system?

In Chromeleon or Chromeleon Xpress, turn off the pump from the ICS-90 (or 
ICS-90A) Control panel (see Figure 2-9). On the ICS-90, turn off the power 
switch on the rear panel (see Figure 2-2).

D.12 How do I store columns?

Columns should be stored in eluent. See the column manual for complete 
instructions. Column manuals are included on the Dionex Reference Library CD-
ROM (P/N 055405).
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D.13 How do I know when a column is dirty?

See the troubleshooting section of the column manual. Column manuals are 
included on the Dionex Reference Library CD-ROM (P/N 055405).

D.14 How do I clean a column?

See the troubleshooting section of the column manual. Column manuals are 
included on the Dionex Reference Library CD-ROM (P/N 055405).

D.15 Why is the conductivity high?

Possible reasons for high conductivity include:

• The suppressor needs regeneration. See the suppressor manual for 
troubleshooting information. Suppressor manuals are included on the Dionex 
Reference Library CD-ROM (P/N 055405).

• The regenerant is exhausted and should be remade. See Section 3.2 for 
instructions on preparing regenerant.

• The DS5 is out of calibration. See Section 5.1.2 for calibration instructions.
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E • Glossary

Analytical Column
Synonymous with Separator Column.

Band Spreading
The broadening of the sample band as it travels through the column. Band 
spreading can also occur in the injection valve, detector cell, and interconnecting 
tubing.

Calibration Curve
A graph showing detector response in peak height or area versus analyte 
concentration.

Capacity Factor (k´)
The number of column volumes of eluent, pumped through the column, required 
to elute an analyte. Capacity factor is a dimensionless measure of retention which 
is independent of column length or eluent flow rate. It is calculated as follows: 

Where: tr = retention time
to = retention time of unretained solute (column void volume)

Cell Constant (k)
A factor determined experimentally by measuring the conductance (G) of a 
standard solution of known equivalent conductivity (k).

k′
tr to–

to
--------------=

k κ G⁄=
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The value of k depends upon the surface area of, and distance between, the 
electrode faces in the conductivity detector cell.

Where: l = length
A = area of one electrode (the other electrode is equal to
the first)

Channeling
The preferential flow of liquid along more open, less resistant paths through the 
column packing. This causes Band Spreading.

Column Efficiency (N)
A measure of the narrowness of analyte bands as they elute from the column. 
High efficiency is desirable because resolution between closely spaced bands 
improves with greater efficiency. For a symmetrical (Gaussian) peak, column 
efficiency can be determined by the following:

N = 5.54(t1/W1/2)2

Where:  t1 = the peak retention time, in seconds
W1/2 = the peak width at 1/2 height, in seconds

Column efficiency is proportional to column length: for a given resin and column 
diameter, increasing the column length increases the column efficiency. 
Synonymous with Theoretical Plates.

Column Selectivity (a)
Describes the relative separation of the band maxima between two adjacent peaks. 
Selectivity can be determined by the following:

a = (t2 - t0)/(t1 -t0)

Where: t1 and t2 = retention time of components 1 and 2, respectively
t0 = retention time of unretained components (void volume)

Concentrator Column
A short column used to retain and concentrate analytes from a measured volume 
of relatively clean sample. This allows large volumes of sample to be injected, 
lowering concentration detection limits.

Conductivity
A measure of the ease with which electrical current flows through a liquid 

k l A⁄=
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contained between two opposite charged electrodes. Conductivity is a 
characteristic of ions in solution. Units are siemens.

Counterion
Ions carrying a charge opposite that of the sample ions (e.g., Na+) may be the 
counterion of a Cl- analyte. These ions preserve electrical neutrality in solution.

% Crosslink
Divinylbenzene content in a polystyrene/divinylbenzene (PS-DVB) resin; this 
contributes to the mechanical strength of the resin and determines 
chromatographic properties.

Electrical Conductance

Equivalent Conductivity (λ)
The contribution of an ionic species to the total conductivity of a solution as 
measured in a standard cell having electrodes 1 cm2 in area and exactly 1 cm 
apart.

Guard Column
A small column that prevents poisoning of the separator column by sorbing 
organic contaminants and removing particulates. It is filled with the same packing 
as the separator column. Synonymous with Pre-Column.

HETP (H)
Height Equivalent to a Theoretical Plate. A measure of column efficiency which 
allows comparison between columns of different lengths.

HETP = H = L/N

Where: L = the column length (mm)
N = the number of theoretical plates

Ion-Exchange Capacity
The number of active ion exchange sites in a given weight or volume of resin; this 
is usually expressed in meq/g or meq/mL.

Ion-Exchange Resin
An insoluble polymer matrix containing fixed-charge exchange sites (anionic or 
cationic). IC resins are formed into small spherical particles (beads).

Packing
The material that fills a chromatographic column; usually a resin or silica-based 
material.
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Pellicular Resin
A resin with a solid, nonporous core coated with a thin layer of more porous 
material. The exchange sites of pellicular ion exchange resins are located only on 
the surface layer of the bead. These resins have a low ion-exchange capacity.

Pre-Column
Synonymous with Guard Column.

Regenerant
A dilute acid or base which converts ion exchange sites in the suppressor back to 
the form which will suppress the eluent conductivity.

Resin
See Ion-Exchange Resin.

Resolution (R)
A measure of the separation between two sample components. It is expressed as 
the ratio of the distance between the two peak maxima to the mean value of the 
peak width at the baseline.

R = 2(t2 - t1)/(W2 + W1)

Where: t1 and t2 = the retention times of components 1 and 2,
respectively
W1 and W1 = the baseline width of peaks 1 and 2,
respectively (measured in the same units as the retention
time)

R is proportional to the square root of efficiency (N). A value of R = 1.5 
represents “baseline separation” of the two peaks.

Retention Time
The time from injection to peak maximum; the basis for identification of a species 
in chromatographic analysis.

Separator Column
The column used to perform a chromatographic separations; also called analytical 
column.

Siemens (S)
Unit measure of conductance; the reciprocal of the electrical resistance of a 
solution.
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Suppressor
A device used to minimize eluent conductivity and convert sample species to a 
common form, thus increasing detection sensitivity.

Temperature Coefficient
The percent of change in the conductivity of a solution with a 1 oC change in 
temperature. Every solution has a characteristic temperature coefficient which is 
determined experimentally. 

Theoretical Plates (N)
See Column Efficiency.

Void Volume (V0)
The volume occupied by the eluent in a packed column. This volume includes the 
volume between the injection valve and the column, as well as between the 
column and the detector cell. Unretained components are eluted in the void 
volume.
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Index

A
Air particulate samples, 28
Air regulator, 26, 99, 105
Alarms, 39

Load/inject valve error, 41 – 42
Over conductivity alarm, 41
Pump over pressure alarm, 40
Pump under pressure alarm, 40

Ambient temperature, 49
Analytical column, 19

See also Columns
Anion regenerant, 11
AS40 Automated Sampler

Installation, 112
Sample injection, 36
TTL output connector, 14

Audit Trail, 39, 53
Auto offset requirements, 78
Autozero, 32

B
Background conductivity

High, 42, 48
Offsetting, 32, 34

Backpressure
Restriction in plumbing, 61
Troubleshooting, 45

Backpressure coils, 102, 104
Baseline drift, 49
Baseline noise, 20, 49
Blockages

Liquid lines, 40, 61

C
Cables

Power cord, 72
USB, 89

Calibration, 51
Cell, 51, 55
Downloading factory calibrations, 53
Flow rate, 51, 56
Pressure transducer, 51, 54

Carbonate eluent, 11
Cation eluent, 11
Cation regenerant, 11
Caution icon, 5 – 6
Cell

See DS5 Detection Stabilizer
Check valves

Cleaning/replacing, 61
Chromeleon/Chromeleon Xpress

Audit Trail, 39
Communication with ICS-90, 13
Creating a timebase, 92
Error messages, 39
ICS-90 Control panel, 32
License, 85
Menu, 32
Overview, 23
Setup, 83
Toolbars, 32
USB driver information, 83
User interface, 23
Wellness panel, 51

Columns
Cleaning, 119
Contaminated, 47
Guard, 19
Installing, 102
Separator, 19
Storing, 118
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Commands, 33
Component mounting panel, 15

Columns, 19
DS5 Detection Stabilizer, 15
MMS III suppressor, 17
Pressure transducer, 17
Prime valve, 19
Pump, 19

Computer
Unpacking, 82

Conductivity
Causes of high conductivity, 119
Selecting the range, 94
Temperature effect, 16

Conductivity cell, 15
See also DS5 Detection Stabilizer

Control panel
See ICS-90 Control panel (in software)

D
Danger icon, 5 – 6
Data

Backing up, 118
Deleting, 118

DCR
See Displacement chemical regeneration

Decibel level, 75
Delay volume specifications

System total, 78
Detector specifications

Auto offset, 78
Cell drive, 78
Control and data evaluation, 78
Linearity, 78
Range, 78, 94
Temperature compensation, 78

Diagnostics, 51, 53
Dimensions, 75
Displacement chemical regeneration, 21
Dongle, 85
DS5 Detection Stabilizer, 15

Calibration, 55

High cell output, 48
No response, 48
Replacing, 70

DS5 Detection Stabilizer specifications
Active volume, 78
Cell body, 78
Electrodes, 78
Maximum pressure, 78

Dummy cell, 48, 53

E
ECD

See Electrochemical detector conductivity
Electrical specifications

Fuses, 75
Main power, 75

Electrochemical detector conductivity, 53, 93
See also Conductivity

Eluent, 11
Delivery process, 1
Preparing, 25
Pressurizing the reservoir, 26
When to remake, 118

Eluent reservoir, 11
Pressurization, 26, 105

Environmental specifications
Gas pressure, 76
Humidity, 76
Operating pressure, 76
Operating temperature, 76

Equilibration time, 32
Error messages, 39

F
Facility requirements, 79
Fittings

Leaking, 42
Replacing, 59
Requirements, 59

Flow path, 20
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Flow rate, 77
Setting, 107
Troubleshooting, 45

Fluid schematic, 20
Front panel, 10
Fuses

Changing, 72
Requirements, 75

G
Gas source

Installation, 99, 102
Pressure requirements, 76, 99

Ghosting, 46
Guard column, 19, 102

H
High pressure alarm, 40
Hub (USB), 88
Humidity limits, 76

I
Icons used in manual, 5
ICS-90

Component mounting panel, 15
Flow path for system, 20
Flow rate, 77
Front panel, 10
Rear panel, 12
Top cover, 10
Warranty, 51
Weight, 80

ICS-90 Control panel (in software), 32
Important icon, 5
Injecting sample

Syringe injection, 35
Vacuum syringe technique, 36
Via the AS40, 36

Injection events, 34

Injection port, 10
Injection valve, 18

Automatic reset, 34
Leaking, 43
Rebuilding, 69
Specifications, 78

Installation
AS40 autosampler, 112
Chromeleon/Chromeleon Xpress setup, 83
Columns, 102
Gas source, 99, 102
Operational status verification, 112
Power connection, 90
Priming the pump, 106, 111
Setting up the eluent and regenerant, 100
Starting the ICS-90, 91
Suppressor, 104

Ion chromatography overview, 1
Ion exchange, 1
Isocratic delivery system, 1

L
Leaks

Fittings, 42
Injection valve, 43
Liquid, 42
Pressure transducer, 43
Pump head waste valve, 43
Suppressor, 43

LEDs
Link, 13
Status, 10

License, software, 85
Lifting the ICS-90, 80
Line frequency, 90
Linearity requirements, 78
Link LED, 13, 77
Liquid leaks, 42
Load/inject valve alarm, 41 – 42
Loop, 18

Changing, 60
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M
Main power receptacle, 13
Maintenance, 37

Daily, 37
Ongoing, 37
Weekly, 37
Yearly, 38

Messages
Safety, 5

Methanesulfonic acid eluent, 11
MMS III suppressor, 17

Displacement chemical regeneration, 21
Installing, 102
Leaking, 43

N
Nitrite in samples, 28

O
Operating features, 9 – 10
Operating pressure, 76
Operating temperature, 76
Operation

Equilibration time, 32
Injecting sample, 35
Post-injection events, 34
Start-up procedure, 29

Over conductivity alarm, 41

P
Panels

Component mounting panel, 15
Front panel, 10
ICS-90 Control panel, 32
ICS-90 Wellness panel, 51
Rear panel, 12

Parameters, 33
Peak ghosting, 46

Peak height
Troubleshooting, 47

PEEK cell body, 15
PGM file

See Programs
Physical specifications

Decibel level, 75
Dimensions, 75
Weight, 75

Piston seal
Replacing, 63

Power cord, 72
Power receptacle, 13
Power requirements, 75
Power switch, 12
Power-up conditions, 29
Pressure

Limit, 40
System, 40, 53

Pressure requirements
Gas source, 76

Pressure transducer, 17
Leaking, 43

Prime valve, 19
Priming procedure, 106, 111
Printing, 117
Programs, 24
Pulse damper, 20

Specifications, 77
Pump, 19

Cleaning/replacing check valves, 61
Flow rate, 107
Flow reduction, 32
Over pressure alarm, 40
Piston replacement, 66
Piston seal replacement, 63
Priming problems, 44
Priming procedure, 106, 111
Pump head assembly, 62
Replacing the waste valve O-ring, 68
Troubleshooting, 44
Under pressure alarm, 40

Pump head waste valve
Leaking, 43



Index

Doc. 031851-08 12/06 Index-5

Pump specifications
Flow rate, 77
Operating pressure, 77
Operation mode, 77
Type, 77

R
Rear panel, 12

Link LED, 13, 77
Power receptacle, 13
Power switch, 12
TTL output connector, 14
Tubing connections, 14
USB receptacle, 13

Rebuilding the injection valve, 69
Recalibration (when to perform), 117

See also Calibration
Regenerant, 11

Acid concentrates, 25, 100
Filling the reservoir, 26, 100
Preparation, 25 – 26, 100
Preparing, 25
Shaking the contents, 26, 100

Regenerant reservoir, 11
Reordering information, 115
Replacing a pump piston, 66
Replacing the DS5 Detection Stabilizer, 70
Replacing tubing and fittings, 59
Reservoirs, 11
Restriction in plumbing, 61
Retention time

Adjusting, 117
Moving, 117
Troubleshooting, 47

Rheodyne valve, 18

S
Safety labels, 7
Safety messages and icons, 5 – 6
Sample injection

AS40 injection, 36
Via syringe, 35
Via vacuum syringe, 36

Sample loop, 18
Changing, 60
Injecting, 18
Injection valve connections, 60
Loading, 18

Samples
Collecting and storing, 28
Diluting, 28
Filtering, 28
Injecting, 35
Preparing, 28
Pretreating, 28

Schematic
Fluid, 20

Selectivity
Troubleshooting, 47

Separator column, 19, 102
Server Configuration program, 86
Server Monitor, 85
Service, 70

Changing fuses, 72
Changing the sample loop, 60
Cleaning/replacing pump check valves, 61
Pump piston replacement, 66
Pump piston seal replacement, 63
Rebuilding the injection valve, 69
Replacing the suppressor, 72
Replacing the waste valve O-ring, 68
Replacing tubing and fittings, 59
Restriction in liquid lines, 40, 61

Shipping screw
Pump, 81

Specifications
Delay volume, 78
Detector, 78
DS5 Detection Stabilizer, 78
Electrical, 75
Environmental, 76
Injection valve, 78
Physical, 75
Pump, 77
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Standards
When to remake, 118

Standby mode, 32
Start-up conditions, 29
Start-up procedure

Chromeleon/Chromeleon Xpress, 30
ICS-90, 29

Status LEDs, 10
Sulfite in samples, 28
Sulfuric acid regenerant, 11
Suppressor, 17

Off-line regeneration procedure, 42
QuickStart procedure, 41
Replacing, 72

Symbols, 7
Syringe injection, 35
System

Shutdown, 118
System status, 52

T
TBAOH, 11
Temperature

Compensating, 16
Control, 16
Minimizing the effect of variations, 16

Tetrabutylammonium hydroxide regenerant, 11
Timebase, 92
Top cover, 10
Troubleshooting

Calibrations, 51
Diagnostics, 51
Error messages, 39
Excessive backpressure, 45
Flow rate, 45
High DS5 output, 48
Liquid leaks, 42
No DS5 response, 48
Peak ghosting, 46
Peak height, 47
Pump, 44
Retention time, 47

Selectivity, 47
System status, 52

TTL output connector, 14
Tubing

Replacing, 59
Requirements, 59

Tubing connections, 14
Isolating a restriction, 40, 61

U
Unpacking, 80

Computer, 82
ICS-90, 80
Removing the shipping screw, 81

USB
Connecting to a hub, 88
Driver, 83

USB receptacle, 13

V
Vacuum syringe injection, 36

W
Warning icon, 5 – 6
Warranty, voiding, 51
Waste lines

Blocked, 42
Connection, 98

Waste valve O-ring
Replacing, 68

Water samples, 28
Weight, 75
Wellness panel, 51

Audit Trail, 53
Diagnostics, 53
Dummy cell, 53
ECD conductivity, 53
System pressure, 53
System status, 52
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Z
Zeroing the baseline

At injection, 34
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